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LICENSE AGREEMENT

IMPORTANT: Do not open the accompanying sealed media package or use the software until you have
read and agreed to the terms of this license agreement.  If you do not agree to abide by the terms of this
agreement, which include the license and limited warranty, you may return the complete software
package unopened to the location where you obtained it within twelve (12) days of the purchase date for
a full refund, as long as the media envelope has not been opened.

1.0 Licensee agrees, by its act of opening the
sealed media package or its use of the Software,
that Licensor’s grant to Licensee of the right to
use and possess this Software shall be subject
tho the following terms and conditions.

1.01 Definition.  The following definitions apply to
this License Agreement:

a) “Licensor” is Data Management, Incorporated,
a Texas corporation, with its mailing address at
3322 West Loop 306, San Angelo, TX 76904,
which owns the rights to the copyright on the
Software and Documentation.

b) “Licensee” is the individual or the business
entity that has purchased this package and the
License to use the Software as an end user under
the terms set forth in this License Agreement.
“Licensee” includes those persons in Licensee’s
immediate organization, such as business
associates, partners, and employees, who are
authorized to use this copy of the Software on the
Computer pursuant to this License Agreement.

c) “Computer” is a single microcomputer system,
using a single processor or a co-processor, on
which Licensee is licensed to use this Software.
Use on multiple CPU systems, networks, or
emulations on mainframe or minicomputers are
not covered under this License and require
licenses available from Licensor at additional
cost.

d) “Software” is the object-code computer
program contained in the media enclosed in the
accompanying sealed package.

e) “Documentation” means the published User
Manual for the Software provided with the
Software.

f) “License” means the right of use defined in this
License Agreement.

1.02 Grant of License.  Licensor grants to
Licensee a nonexclusive right to install and use
one copy of the Software on a single computer at
a single location in accordance with the terms of
this License Agreement.  Licensee may change
the computer on which Licensee is authorized to
use the Software to another Computer within
Licensee’s immediate organization only if the
Software is no longer used on the former
computer.  Licensee owns only the magnetic or

other physical media on which the Software is
recorded or fixed.  Licensor retains ownership of
the Software recorded on the original and other
copies may subsequently exist.  This License is
not a sale of the Licensee’s copy of the Software
or of any subsequent copy.  Licensor may
terminate this License immediately upon the
breach by Licensee of any of the terms or
conditions of this License Agreement.  On
receiving notice of such termination, Licensee
agrees to either destroy or return the original and
all existing copies of the Software to the Licensor.
Licensee agrees to comply with the terms and
conditions of this License and agrees to take all
reasonable steps to protect the Software from
theft or use in a manner inconsistent with the
terms of this License Agreement.  Licensee
agrees not to: make any changes or modifications
to the software, create derivative works from the
Software, or translate, decompile, disassemble,
or otherwise reverse-engineer the Software, or
use or attempt to obtain any techniques,
algorithms, processes, trade secrets, or
proprietary information contained in the Software.
This License is personal to Licensee and non-
transferrable.

1.03 Possessing and Copying.  Licensee agrees
that the Software will only be displayed on, or
read into, or used on, the licensed Computer.
Licensee agrees to make no more than three (3)
copies of the Software for backup purposes only
and to keep the original and all copies in
Licensee’s possession or direct control.  Licensee
agrees to place a label on the outside of each
backup copy made showing the program name
and Licensor’s copyright and trademark notices,
in the same form as they appear on the original
copy.  The transfer of a copy to one hard disk
shall count as one backup copy.  Licensee may
not copy the documentation.

1.04 Transfer or Reproduction.  Licensee may not
rent, lease, sub-license, transfer, network,
reproduce, display, or otherwise distribute the
Software except as specifically provided in this
License Agreement.  Licensee may not transfer
any copy of the Software to another person or
entity outside Licensee’s immediate organization,
on either a permanent or a temporary basis.
Licensee understands that unauthorized
reproduction of copies of the Software or
unauthorized transfer of any copy of the Software
may constitute a criminal offense and subject
Licensee to suit for damages, injunctive relief,



and attorney fees.  Licensee agrees and
recognized that Licensor retains exclusive
ownership of title to the Software, Documentation,
and related trademarks.

2.0 Warranty.  Data Management, Incorporated
warrants that the magnetic media on which the
Software is recorded, and the documentation
provided with it are free from defects in materials
and workmanship under normal use.  Data
Management, Incorporated warrants that the
Software itself will perform substantially in
accordance with the specification set forth in the
then-current operating documentation for the
Software which is provided with the Software.

2.01 Warranty Period.  The above express
warranties are made for a period of thirty (30)
days from the date the Software is shipped to
Licensee and shall terminate after such 30 day
period.  There is no warranty after expiration of
the warranty period.

2.02 Licensee’s Obligations Under the
Warranties.  Licensee must call Data
Management, Incorporated’s technical support
department for authorization in order to return any
defective item to Data Management,
Incorporated, or it’s distributors during the
warranty period.  If Data Management,
Incorporated’s technical support representatives
cannot resolve Licensee’s problem with
reasonable effort via telephone or other means,
Licensee will be provided with a return
authorization number and an address for
returning the defective item for warranty service
or replacement.  Licensee assumes complete
responsibility for items lost or damaged while in
transit and must insure any defective item being
returned.

2.03 Replacement.  During the 30-day warranty
period, Data Management, Incorporated will
replace any magnetic media which proves
defective in materials or workmanship, on an
exchange basis.  In the case of an error in the
documentation, Data Management, Incorporated
will correct errors in the documentation by
providing addenda in hard copy or on magnetic
media, or with substitute pages.

2.04 Correction of Software.  During the 30-day
warranty period, Data Management, Incorporated
will either replace or repair without additional
charge, other than shipping or handling, the
portion of any Software that does not perform in
substantial accordance with the specifications of
the documentation.  This will be done by
delivering to Licensee a corrected copy of the
Software or corrective code, on an exchange
basis.

2.05 Final Remedy.  If Data Management,
Incorporated is unable to replace defective

documentation or defective media or if Data
Management, Incorporated is unable to provide a
corrected copy of the Software or corrected
documentation within a reasonable time, Data
Management, Incorporated will refund the license
fees paid for use of the Software.  Under no
circumstances shall Data Management,
Incorporated be liable for any loss, cost, expense,
or damage in an amount cumulatively exceeding
the License fee for the Software actually paid by
Licensee.

2.06 Sole Remedy.  The preceding obligations of
Data Management, Incorporated with respect to
replacement, correction, or refund are the
Licensee’s SOLE AND EXCLUSIVE REMEDIES.

2.07 Warranty Limitations.  Data Management,
Incorporated does not warrant that the functions
contained in the Software will meet the
Licensee’s requirements or that the operation of
the Software will be uninterrupted or error free.
The warranty does not cover any media or
documentation which has been subjected to
damage or abuse by Licensee.  The Software
warranty does not cover any copy of the Software
which has been altered or changed in any way by
Licensee or others.  Data Management,
Incorporated is not responsible for problems
caused by changes in the operating
characteristics of the computer hardware or
operating system which are made after the
delivery of the Software.  THERE ARE NO
OTHER WARRANTIES OF ANY KIND.  WITH
RESPECT TO THIS LICENSE OR
AGREEMENT, THE SOFTWARE, THE
DOCUMENTATION OR ANY SERVICES OR
GOODS PROVIDED BY LICENSOR TO
LICENSEE IN CONNECTION WITH THE
SOFTWARE, LICENSOR DISCLAIMS ALL
OTHER WARRANTIES, WHETHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, OF FITNESS FOR A
PARTICULAR PURPOSE, OF CONFORMITY TO
ANY REPRESENTATIONS OR DESCRIPTION,
OR ARISING FROM USAGE OF TRADE OR
COURSE OF DEALING OR PERFORMANCE.
THIS LIMITED WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, YOU MAY HAVE
OTHERS WHICH VARY FROM STATE TO
STATE.

2.08 Responsibility of Licensee.  Licensee
represents that it accepts sole responsibility for
(a) the selection of the Software to achieve
Licensee’s intended results; (b) its use; and (c)
the results obtained from the software.

2.09 Damages Limitation.  Even if Licensor has
been advised of the claim or potential of the
following described kinds of damages, Licensor
shall not be liable for indirect, incidental, punitive,
exemplary, special, or consequential damages of



any kind whatsoever, including but not limited to,
any such damages sustained as a result of: any
breach of warranty or of this License Agreement;
any act or failure to act relating to this License
Agreement or the Software; Licensor’s
negligence or gross negligence; or any claim
made against Licensee by any other party.
Licensee agrees that it shall not assert any claims
against Licensor based upon theories or
negligence, strict liability, fraud, or
misrepresentation and that it shall indemnify, hold
harmless, and defend Licensor against any claim,
demand, loss, or action resulting from Licensee’s
possession or use of the Software.  Some states
do not do not allow the exclusion or limitation of
incidental or consequential damages, so
application of the above limitation or exclusion to
you may be limited by state law.  Except as
stated herein above, in no event shall Licensor be
liable for damages of any kind whatsoever,
including, but not limited to, damages for loss of
business profits, business interruption, loss of
business information, or other pecuniary loss,
arising out of the use or inability to use this
product, even if Licensor has been advised of the
possibility of such damages.  Any action by
Licensee for breach of this License Agreement or
other action by Licensee against Licensor must
be commenced within one year after the cause of
action has accrued.

3.0 General.  This License Agreement contains
the entire and exclusive agreement and
understanding between Licensor and Licensee
with respect to its subject matter and supersedes
any and all prior oral or written communications,
proposals, advertising, discussions, agreements,
purchase order, representations, and
understandings between them, and may not be
waived or modified except by a written agreement
of both parties.  No delay or failure by either party
in exercising any right under this License
Agreement and no partial or single exercise of
any right by either party shall be deemed to
constitute a waiver of that right or any other right
under this License Agreement.  The termination
of this License shall not affect the provisions of
this License Agreement, which by their terms and
meaning are of a continuing nature.  If any
provision of this License Agreement shall be held
illegal, void, or unenforceable, the remaining
portions shall remain in full force and effect.  The
paragraph headings in this License Agreement
are for convenience only, form no part of this
Licensee Agreement, and do not affect its
interpretation.  This License Agreement shall be
governed by the laws of the state of Texas.  All of
Data Management, Incorporated’s products are
trademarks of Data Management, Incorporated.

TimeClock Plus, TimeClock Manager, TimeClock
Scheduler, are trademarks of Data Management,
Incorporated within the United States and other
countries.  All other brand and product names are

trademarks or registered trademarks of their
respective companies.

© 1999 Data Management, Incorporated
All Rights Reserved
Printed in USA

Data Management, Inc.
3322 West Loop 306
San Angelo, TX 76904
Telephone  (915) 223-9500
Fax  (915) 223-9104
Internet sales@timeclockplus.com
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1.  Welcome to TimeClock Plus
Congratulations on your purchase of TimeClock Plus for Windows Version

3.0, the latest version of the software on the market today.  Your decision to put
TimeClock Plus to work for your company will start increasing your bottom line
immediately, in many cases recovering the investment in as little as one pay
period.  In addition to the many benefits you will gain by using TimeClock Plus,
your employees will feel more secure in knowing that the hours they are working
are now being tracked and totaled accurately.

Gone are the days of hassling with timecards only to find mistakes in
calculating employee’s hours.   Past time and attendance records are available at
your fingertips, including verification of employee hours by the employee and by
management.

With payroll being one of the highest costs of doing business today, you will
find the many management tools available in TimeClock Plus invaluable.  From
controlling employees’ clock times to controlling their overtime hours you will be
in control of your payroll.

Scheduling employees with TimeClock Plus Scheduler will take a fraction of
the time it used to take using the manual method.  Matching employees with
shifts will help insure you don’t leave yourself short at any time.  Use the
scheduler to project your payroll costs, restrict employees from clocking in early
or late, and compare actual to scheduled labor costs, helping you to find ways to
trim your labor costs.  Copy the current weeks schedule, make any adjustments
necessary and you now have next week’s schedule ready.

How this User Reference Guide is organized

This guide includes two volumes, a User Guide and a Reference Guide.
The User Guide consists of procedures for installing, configuring, using and
maintaining your TimeClock Plus system.  In order to have a trouble free
installation and smooth transition from your old system it is suggested that you
read through this volume before installing and using TimeClock Plus. The
Reference Guide is an alphabetical list of features and functions with
procedures and examples.

Conventions used in this guide.

In step-by-step procedures, all buttons, dialog box titles and options appear
in bold type.

Periodically while using this guide, you may see the following symbols:

This symbol accompanied by text indicates new features in 3.0.
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This symbol accompanied by text indicates important steps and should
be given close attention.

Comments about this guide?

Your input is very valuable to us.  If you have any suggestions or comments
on how we can improve this documentation send an e-mail to:

support@timeclockplus.com or fax us at (915) 223-9104

What is included

TimeClock Plus for Windows version 3.0 is distributed on CD-ROM media.  If
you do not have a CD-ROM drive on your computer you may request that
TimeClock Plus be sent to you on 3½-inch diskettes, for a nominal charge.

TimeClock Plus is a full 32-bit program, however due to the hardware
limitations on many existing networks, a 16-bit version of the on-screen
TimeClock Plus is included for use on the systems running Windows 3.1.  No
management functions are supported on 16-bit platforms such as Windows 3.1.

The following is a list of the components you will be installing and a
brief description of each:

Programs Description

TimeClock TimeClock Plus is used for clocking in and out on your
computer.

TimeClock Manager

The TimeClock Manager is used to perform all
management functions such as adding employees,
printing reports, and viewing employee information and
labor costs.  Many other features are also included in
this program and are also discussed later in this guide.

TimeClock Scheduler

TimeClock Scheduler is used to build employee
schedules.  It is necessary to schedule employees in
order to take advantage of absent and tardy reports as
well as rounding to scheduled shifts.

Time Server*

The Time Server is designed to run on a workstation on
your network allowing TimeClock Plus to obtain the time
from the server and not the local workstation.  This
program is included only in the network version of
TimeClock Plus.

Time Server Service* The Time Server Service is designed to run as a service



TimeClock Plus Users Guide 3

on Windows NT, allowing workstations running
TimeClock Plus to obtain the system time from the
server.  This program is included only in the network
version of TimeClock Plus.

WinRemote

WinRemote is designed to run on Windows 95, 98 and
NT.  This program is only necessary if you are
connecting a remote data entry terminal to the
workstation.

Auto Import

(Additional Module)

The Auto Import application is used to perform an
unattended import of clock data.  This is useful when
using another application to collect the data for import
into TimeClock Plus.

Auto Update

Auto Update is designed to periodically update the
TimeClock Plus applications using the internet.  This
application should be run on a regular basis to ensure
that you are running the latest versions of all software.
This can only be done if you have internet access.

Time Server Tester* Tests the functionality of the Time Server from a client
computer.

*Denotes items that are only available in the network version of TimeClock Plus.
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2.  TimeClock Plus Concepts

Dates and Times

Whenever you are prompted to enter a date or time, you may either enter it
directly into the box or click on the icon next to the edit field and a window will
appear allowing you to select a specific date or time.

Times can be entered in either 12 hour or 24-hour format, with or without a
colon.  The following entries are acceptable and all refer to the same time.

5:00PM      5:00P      500PM      500P      17:00      1700

Dates can be entered using the full year such as 1999 or they can be
entered using just the year portion of the date.  For entry of most dates in the
system, if just a year is entered, values of less than 70 are treated as being in the
year 2000.  Values of 70 and above are treated as though they are in the year
1900.  For example, if you enter 01/01/05 the date is recorded as January 1,
2005.  If you enter 04/02/99, the date is recorded at April 2, 1999.

Calculator

TimeClock Manager includes a pop-up calculator, which can be accessed
from the tools menu as well as holding down CTRL and pressing C.

Calendar

TimeClock Manager includes a pop-up calendar, which can be accessed
from the tools menu as well as holding down CTRL and pressing D.

Shifts and Breaks

A shift is the time between when an employee clocks in and when that
employee clocks out, including any breaks taken during this time whether they
are paid or not.

A break is a period of time during which the employee is not clocked in, but
is still part of the current workforce.  Employees on break do not show up as
absent for that day.

Job codes

Job codes are used to track employees’ hours in a specific department, i.e.
waiter, dishwasher, hostess, etc.  Employees may be assigned one or more job
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codes and may clock in and out under one or more of those job codes during the
day, allowing you to track the amount of time spent in that department.  In
TimeClock Plus, each position or department is setup as a job code.  The job
code is a number used to refer to that position or department.  Two non-
clockable job codes are automatically created when you install TimeClock Plus.
These job codes are sick time and vacation time and are assigned to all
employees.  At least one clockable job code will need to be added before an
employee can clock in or out of the system.

Cost codes

Many businesses frequently have multiple customers or projects at any
given time, and it is helpful to know how much time is being spent on each.  For
instance, an automobile repair shop may need to track exactly how many man-
hours are being spent on each car in order to properly bill the customer.
TimeClock Plus has the optional Job Cost Module to facilitate this.

The Job Cost Module is an optional product available from Data
Management which allows employees to clock in with a cost code.  The
difference between job codes and cost codes is important.  Each employee is
expected to have only a few job codes, and those codes change infrequently.
Conversely, there is no limit to the number of cost codes available, and those
codes are easily changed.  Also, employees are assigned job codes individually,
whereas cost codes are assigned for the company as a whole.  If you are
interested in purchasing the Job Cost Module, contact Data Management at
(915) 223-9500.
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3.  Installing TimeClock Plus

The installation program included on your TimeClock Plus CD, will
walk you through the installation process; however before you install
you should verify that your computer meets the minimum requirements.

System requirements

Your computer should meet the following minimum requirements before
installing TimeClock Plus.

• 386 processor
• Windows 95, 98 or NT
• Mouse
• 10 MB free disk space
• 8 MB memory
• VGA monitor
• 2X CD-ROM drive
• Internet access recommended

Installation

If you are upgrading from a previous version of TimeClock Plus, it is
recommended that you backup your existing TimeClock Plus installation before
installing TimeClock Plus 3.0.

Creating Diskettes from the CD-ROM

If you have access to a CD-ROM on a computer other than the computer
where TimeClock Plus is to be installed, you can create diskettes from the CD-
ROM by following these steps (three formatted 1.44MB diskettes are required):

 1) Insert the CD into the drive
 2) Click on the Start Menu and select Run
 3) Enter “X:\Utility\MakeDisk” and press ENTER (where X: is the drive

letter of your CD-ROM drive)
 4) Follow the onscreen instructions to make the diskettes.

Starting the installation

To begin the installation of TimeClock Plus 3.0 for Windows, insert the CD
into your CD-ROM drive.  If Auto Run is enabled the install will automatically
start.  If Auto Run is not enabled, click on the Start menu and select Run.  Enter
“X:\SETUP” in for the program name and click the Ok button (where x: is the
drive letter of your CD-ROM).
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If you have ordered or created 3.5” diskettes, the setup program can be run
by inserting the first disk into your drive, clicking the start menu, selecting
Run, and entering “A:\SETUP” or “B:\SETUP” depending on the drive letter
of your floppy drive.

Once the Install application is started it will check to make sure that no
TimeClock 3.0 applications are running on the system.  If TimeClock applications
are running, you will be presented with a screen similar to the following.

If you see this screen, you should terminate the applications that are running
on the system.   Once all applications have been terminated, select Continue
Install to proceed with the installation.  Note also that if you are reinstalling
TimeClock Plus 3.0 on a network, all users on the network must be out of
TimeClock before attempting the install.  If users are still running the TimeClock
applications, they will not be updated.

If you are performing an install on a Windows NT system and the Time
Server service is currently running, you will get the following message:

In order for the Time Server service to be updated it must be stopped.  Note
that during the period the Time Server is stopped no client computers will be able
to retrieve the time from the server.  If you are upgrading from a previous version
of TimeClock Plus, the Time Server should be stopped.  If you are merely
reinstalling TimeClock Plus on this computer it is not necessary to stop the
service.
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The first screen of the installation is the Welcome screen.  Press the Next
button and the license agreement will be displayed.  When you have read and
understand the license agreement, press the Next button to proceed.

You are now prompted to enter your company name and serial number.
Your serial number can be found on the inside front cover of your TimeClock
Plus User Reference Guide.  If this is the first time that TimeClock Plus 3.0 is
being installed on this system, both fields will be blank.  Enter your company
name and serial number and press the Next button to continue.   Note that you
must enter a valid serial number before the installation system will allow you to
proceed.

If you are installing a network version of TimeClock Plus, please skip to the
section titled Network Installation.

Single User Installation

At this point you will be prompted to enter the directory where you would like
to install TimeClock Plus.  If you have a previous version of TimeClock Plus
1.0/1.1/2.0 for Windows installed on this system you are given the opportunity to
install version 3.0 into any of those directories.

To install into the 1.0/1.1 or 2.0 directory, select the appropriate radio button
for your desired install.  If you would like to use the default 3.0 directory or you
would like to specify a different directory, choose Specify Directory and type the
directory name in the edit box.  Press the Next button to proceed.

Skip to Finishing the Install for further documentation.

Network Installation

The first screen displayed on the network installation is the selection of a
Server or Client installation.  The first install should be a server install.  The
server install will copy all of the necessary TimeClock files to the installation
device.  A server install should only be performed on one computer in the
network.  Once a server install has been completed, you should perform a client
install on each of the clients on the network that are to have access to TimeClock
Plus.  The number of client machines that you install should not exceed the
number of licenses purchased.

If you are performing a server installation, please refer to the documentation
a few paragraphs back for a Single User Installation.  If you are performing a
client installation you will be presented with the following screen.
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Since TimeClock Plus should already be installed on the network, all that
needs to be done is to tell the client computer where to find the TimeClock
applications.  If you have mapped a drive letter on the client computer to
represent the TimeClock directory, enter that drive designation here.  For
example, you may have mapped the TimeClock program directory to the drive
letter “T”.  If that were the case, you should enter “T:\” on this screen.  When the
directory is entered, press the Next button to proceed.  If the setup cannot find
the necessary files and error message will be given and you must re-enter the
directory.

If you are familiar with UNC path names, the program directory
can also be entered in the form \\SERVER\SHARE.  For example, if
you have installed TimeClock Plus on a server called OFFICE and
shared the TimeClock directory as WINTCLK3; you can specify
“\\OFFICE\WINTCLK3“ as the program directory when installing
on the client computer.

Finishing the Install

Once the directory has been set, you will be prompted with the following
screen.
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This screen is used to determine which icons will be added to the desktop of
the current workstation.  By default, icons for all TimeClock programs will be
checked.  If you are installing on client computers and only wish to have certain
icons added to the TimeClock Plus folder, you can remove the checks from the
unnecessary applications.

Some of these items are not available in the single user version of
TimeClock Plus so the screen may vary slightly.

When all icons are selected press the Next button.  You will then be
presented with a summary screen detailing the installation options that you have
chosen.  If the options are correct, press Finish to start the installation.  If
something is incorrect press the Back button to return to the appropriate screen
and correct the error.

Once the installation of TimeClock Plus is complete you will be asked if you
would like to complete the TimeClock Plus registration form.  Registering can be
done online (requires Internet access) or the form can be printed and faxed.   If
you would like to register select Yes and complete the registration form.  If you
would like to register at a later time, select No.  The registration can be accessed
at any time by running the AutoUpdate program from the TimeClock Plus group
on the Start menu and selecting the Registration option.

If you are performing a single user install or a server install you will then be
asked if you would like to run the TimeClock Manager to begin system
configuration.  If you would like to start TimeClock Manager to create a company
and/or convert previous TimeClock data, select Yes.  If your configuration has
already been done or you would like to do it at a later time, select No.  Note that
no TimeClock applications can be run until the initial company configuration is
done from TimeClock Manager.

The installation is now complete.
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Company Setup

In order to use any of the TimeClock Plus applications you must first create
a company and select a location to store the data for that company.  By default
TimeClock Plus will allow the creation of one company.  If you have a need to
maintain more than one company in the software, an additional Multi-Company
module can be purchased from Data Management, Inc.  The multi-company
module can be useful if a payroll department maintains data for several different
companies via one copy of the TimeClock Plus software.

To begin the process of creating a new company or modifying the settings
for an existing company, you should launch the TimeClock Manager.  If you are
launching TimeClock Manager for the first time, the software will notify you that
there are no companies created and take you directly into the company
configuration dialog.  If you currently have one or more companies created, you
can select cancel at the login prompt to TimeClock Manager and choose Select
Company from the File menu to enter the company creation and editing screen.

To create a company, press the Create button.  If you have not exceeded
your limit on the number of companies you can create, you will be prompted with
the first screen of company information.

Enter the company id and company name for the company you are creating.
The company id must be a unique value.  The company ID is be used to
associate a numerical value with the selected company.   Each of the TimeClock
applications can be run with the command line option “/COMPANY:<x>” where
<x> is a valid company ID number.  For example, if you want to run WinRemote
and force it to use company 101, you could execute the application with
“WINRMT32.EXE /COMPANY:101”.  If the company does not exist and there is
more than one active company, you will be asked to select the company to use.

When a valid company name and ID have been entered press the Next
button to proceed with the next company configuration screen.
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This screen is used to configure the location of TimeClock databases for the
selected company.  By default, TimeClock Plus defaults to creating its data
directories off the program directory.  It is recommended that the default directory
is used, but it can be changed if desired.

If a previous version of TimeClock Plus was installed on the system, you can
also attach to those directories by selecting the “Use version 1.0/1.1 directory” or
“Use version 2.0 directory”.  If either of these options is selected, the data will
only be accessible through TimeClock Plus 3.0.

If you would like to keep the existing TimeClock 1.0/1.1/2.0 data intact, it is
best to specify a new directory for version 3.0 data.  Once the new directory is
created you will have the option of copying existing data into the newly created
company.

Once you have specified a new directory, press the Next button.  If the
directory does not exist it will be created for you.  You will then be asked if you
would like to copy existing data into the company.   If you answer no, an empty
company will be created.  If you select yes, you will be prompted for the location
of the data you would like to convert.  Select the location of the previous version
of TimeClock Plus data.  When the software has verified the integrity of the
previous version of data you will be prompted with a conversion screen.

In some instances it may not be necessary to convert all data and schedules
from the previous version of TimeClock Plus.  If you would only like to convert
specific dates of history or schedule data, select convert specific data and select
the starting dates of the schedules and clock information you would like to
convert.  If you would like to convert employee photos and employee notes,
make sure there are check marks in the appropriate boxes.  When you are ready
to proceed with the conversion press Go.  If you would like to cancel the
conversion and return to the previous screen, select Cancel.

Once the new TimeClock company is created and data is converted you will
be prompted to configure some options for the new company.
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TimeClock Plus tracks time by job codes (departments).  The job codes for
sick and vacation times are assigned to each employee.  In the fields provided,
enter the numerical values you would like to use to represent sick and vacation
time.  If you have converted data from a previous version, the values from that
data should be displayed.  If this is a new install, the default values of 1000 and
1001 will be displayed.

Regardless of your pay frequency TimeClock Plus tracks hours on a weekly
basis.  Overtime is calculated on a seven-day workweek.  In the space provided
under Period Base Date, enter the date of the first week TimeClock Plus will be
used to collect data for this company.  This is not necessarily the first day of the
pay period.  For example, you may calculate payroll on a semi-monthly basis
from the 1st to the 15th and the 16th to the end of the month, but your overtime is
calculated on a week from Sunday to Saturday.  In the period base date enter the
date of the first Sunday to Saturday week that you will be using TimeClock Plus.

When you have entered all of the values, press the Finish button to
complete the creation of the company.  You will then be asked to confirm that the
dates entered are correct.  Once you have confirmed that they are correct the
system will check all data in the directory to ensure that is conforms to the dates
entered.  If the system finds data in the directory that does not conform to the
dates entered, you will be warned that the data exists and be given the
opportunity to change the date settings.  For example, if you have specified a
date that falls on a Sunday and TimeClock finds data in the directory that was
tracked on a period beginning with a Monday you will be given an error.  If you
choose to ignore the error, the existing data will be inaccessible to the TimeClock
system.

The company is now created.  To access the company, double click it in the
list or select it and click the Select button.  If only one company is created, all
TimeClock Plus applications will default to using it.
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4.  Configuring TimeClock Plus

Now that you have successfully installed TimeClock Plus on your computer
you are ready to configure defaults, setup job codes and enter employees.

TimeClock Plus as a whole is made up of several program components,
each carrying out a specific function while working together and sharing data.
These individual components make up the TimeClock Plus System.

TimeClock Manager is the program you will be using to set up your
employees and job codes.  You can easily move around using the drop down
menus or the toolbar, which consists of icon buttons.  Place the mouse pointer
over a button or selection and you will see a “hint” appear on your screen
describing the use of that selection.  The toolbar may be moved around the
screen by positioning your cursor over a clear spot near the buttons, holding
down the mouse button and dragging to another location.

Entering job codes

The first step in setting up TimeClock Plus is to enter the job codes you will
be using.  Job codes are numbers assigned to identify particular positions or
departments under which your employees are paid.  By default TimeClock Plus
adds two job codes to your system.  These are job codes for sick and vacation
time and were entered when the company was created.  Since these are not
clockable job codes, you must enter at least one clockable code for employees to
clock in and out.

To add a job code to the Master Job Code list:

 1) Load TimeClock Manager.
 2) From the Configuration menu, select Master Job Code List.
 3) Click Add.
 4) Fill in the fields with the appropriate values.  Refer to the following table

for descriptions of each field.  Most of the fields are optional.
 5) Click Ok.
 6) Repeat from step three for each job code that you want to add.

Field Descriptions

Job Code The number assigned to identify this code (Required)

Description A verbose description of the job (Required)

Exports as The identifier used by your payroll software to refer to this job
code when exporting.
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Default rate The default hourly pay rate.  This can be changed on a per
employee basis.

Job Defaults

Job code is clockable This should be checked if your
employees can clock in and out under
this job code.  If this box is not
checked, an administrator must
manually enter hours worked under
this job code.  Most job codes are
clockable.  Exceptions are vacation
and sick pay job codes.

Hours worked can earn overtime This should be checked if the
employee can be eligible for overtime
pay while working under this job code.
The other requirements for overtime
must still be met (See Overtime p. 73
in the Reference Guide).

Hours worked count toward overtime This should be checked if this counts
toward the minimum hourly
requirements for overtime.  This option
is always checked if Earns Overtime is
checked.

Requires entry of “tips” on clock out. This should be checked if the
employee must enter tips (or another
tracked field) at the end of each shift
(See Tips p. 77 in the Reference
Guide).

Breaks – Auto Deductions

Deduct X minutes for shifts over Y
hours.

For all shifts worked under this job
code for for shifts over Y Hours,
TimeClock Plus will automatically
deduct an X minute unpaid break.

Example:  If a job code is set to
deduct 60 minutes for shifts over six
hours, then an 8 hour shift under that
job code will count as 7 hours, while a
4 hour shift will count as 4 hours.

NOTE: In order for an auto deduction
to take place there can be no clocked
breaks in a shift.
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Breaks - Clocked Breaks

Paid/Not Paid This determines whether or not
clocked breaks are paid under a
specific job code.  This setting only
applies to breaks where the employee
actually uses the break key to clock out
for a break.

Clock Breaks are paid if they do not
exceed X minutes.  A maximum of Y
minutes is paid.

If breaks are paid, this sets the
maximum length of paid breaks at a
duration of X and the maximum
amount of time the employer is willing
to pay to Y.  This could also be viewed
allowing Y minute paid breaks with a
grace period of X minus Y minutes.

Example: If you would like to have
your employees clock out for each of
the 15 minute paid breaks in the
morning and afternoon and also clock
out for an unpaid 30 minutes lunch,
you can set breaks are paid if they do
not exceed 18 minutes, and a
maximum of 15 minutes are paid.  This
will ensure that breaks under 15
minutes are paid the actual length,
breaks 15-18 minutes are paid for 15
minutes and breaks over 18 minutes
are unpaid.

Auto Out

This option enables auto clock out on a particular job code.  This can be
used when an employee clocks in for a known number of hours and then leaves
the site.  It can also be used for such things as meetings where all individuals
attending a meeting are paid a certain number of hours.

Example:  L&M Grocery requires all employees to attend a training session once
a month.  These sessions last from 30 minutes to an hour, but the employees are
always paid for 1 hour of work.  The manager creates a job code 101 with an
auto out value of 60 minutes.  When the employees clock in under this job code
they are automatically clocked in and then clocked out an hour later.

Adding Employees

The next step is to enter employee information into the system.  Employees
will be assigned a unique number that will identify them throughout the system.
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The employee will use this number to clock in and out as well as go on break,
change job codes and change job cost codes.  This number can either be
assigned by TimeClock Plus or can be determined by you using any number up
to ten digits, such as social security number, internal employee IDs, etc.

Employee defaults such as required fields, sick tracking, vacation tracking,
and message history should be set up before you enter any employees.
Selecting Configuration, Preferences, Defaults accesses these options.

An employee template may also be setup allowing you to enter information
your employees may have in common such as job codes, overtime calculations,
restrictions, etc.  This feature prevents you from having to re-enter this
information.  The employee template is accessed from the Template selection in
the TimeClock Manager Employee menu.

In addition to the template, employee default information can be
setup for certain screens in the employee data.  For example, if all of
your employees receive accruals based on the same policy, the accrual
screen can be configured in the default information and each employee can be
setup to use the default information instead of their individual employee record.
In the future if accrual changes are necessary, the amounts need only be
changed in one location.  The employee defaults can be accessed from the
Employee Defaults selection in the Employee menu.

To add employees:

 1) From the Employee menu, select Add...
 2) Enter the employee number you want to assign this employee or use

the default by clicking Ok.
 3) Enter the employee’s name.
 4) Enter the employee’s address, social security number, telephone

number, date of birth, date hired, race and sex.  These entries are
optional unless marked as required in the TimeClock defaults.

 5) If you use a payroll package, enter the payroll package’s code for this
employee in the Employee Code field.  Example:  If John Doe is
identified by #123 in TimeClock Plus but as ABC456 in your payroll
package, then enter ABC456 here.

 6) Leave the Left field blank.  If you enter a date in this field, the employee
will be unable to clock in after that date.  This field denotes the date the
employee “left” the company.

 7) If you want to divide your employees into classifications, such as
departments, location, or by manager, enter the appropriate number in
the Classification field.

 8) The three fields marked Unused are for your own use.  See the
Reference Guide p. 65 for more information.

 9) If you want this employee to not be able to clock in or out, switch the
Suspended field to Yes.

 10) If you have the optional Job Cost module and want this employee to use
cost codes, switch the Job Costing field to On.

 11) Verify all information on the screen, then click on the Jobs tab.
 12) Click Add.
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 13) Enter the job code in the box labeled Job Code Number, or click on the
button and select the job code from the list.

 14) If the job code you want to assign this employee is not listed, you may
click on New Code and enter a new job code.

 15) Enter the pay rate in the box labeled Pay Rate.  You may also enter the
date the pay rate was last changed in the Rate Change box.

 16) If you want the employee to be able to clock in under this job code,
check the Code is Clockable checkbox.

 17) If the employee is eligible for overtime while working under this job
code, check the Earns Overtime checkbox.  If the employee does not
earn overtime, but the job code counts toward the minimum number of
hours required to earn overtime, turn on the Counts toward overtime
checkbox.

 18) If the employee is required to enter tips or another tracked field (see
Tips in the Reference Guide), turn on the Required Tips Entry check
box.

 19) Click Ok.
 20) Repeat from step 12 for each job code that you want to add.
 21) Click on the Overtime tab.
 22) If you want to use defaults you have already setup for overtime, select

the Use Default Information box, if not proceed with the next step.
 23) Select the overtime calculation method you want to use for this

employee.
 24) Enter the Overtime Factor for weekly overtime in the Overtime #1 box,

for daily overtime enter the factor in the Overtime #2 box.
 25) Enter the number of hours before overtime starts in the appropriate box.
 26) If you selected Salaried or Set Amount of Pay under Calculation

Method, enter the Salaried amount per week.

Your employee is now set up and ready to clock in.  You can stop
here and continue adding more employees, or you may want to
configure sick and vacation accruals or schedule restrictions.

Accruals

TimeClock Plus has the ability to track employees’ accrual of sick and
vacation time based on normal hours worked.  Accruals can be set up
individually for each employee, or they can be setup as defaults in the Employee
Default Information screen.

Enter the number of hours the employee will earn of sick and/or vacation
time for each calendar month worked, each calendar week worked, each counted
hour worked or each day worked.  You may also enter the minimum number of
hours you require the employee to work in a day and/or week to qualify for the
accruals.  You can also enter the maximum number of hours that the employee
can accrue.

The number of hours accrued to date can be viewed on this screen, as well
as the number of accrued hours that have been unused.
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The accrued hours can be reset, or used hours can be subtracted from the
accrued hours (setting the used hours to 0 and the accrued hours to the number
of hours remaining).  For more information see Reset Tracked Fields in the
Reference Guide p. 75.

Restrictions

This section includes Auto Rounding (No schedule required) as well as
Clock In Restrictions and Employee Msg.

The Auto Rounding feature allows the employees hours to be rounded up or
down to the specified time when clocking in or out.  Click on the Clock In box.
Enter the number of minutes to round the employee’s time to in the first box, and
the division of time when you want to start rounding up in the second box.  Do
the same for clocking out.

Example:  Dr. Wilson wants TimeClock Plus to round clock in times to the
nearest 15 minutes, rounding down if the employee clocks in from zero to seven
minutes after the quarter-hour and rounding up at eight minutes.  He enters  “To
Nearest 15 Minutes.  Round up at 8 minutes.”

Employees can be restricted from clocking in or out under various
conditions.  Restrictions can be set up individually for each employee or they can
be setup up as defaults in the Employee Default Information screen.  If you want
to use the defaults, check the box by Use Default Information.  Employees can
be restricted from clocking in or out too far outside of their scheduled time, and
restricted from clocking in after they start accumulating overtime, reach a
specified number of hours, after a particular date, or completely restricted from
clocking in.

Employees can be restricted from clocking in after they start earning
overtime.  This only restricts employees who are clocking in, not clocking out.  If
an employee starts earning overtime during a shift, this restriction does not take
effect until the next time that employee clocks in.

To restrict an employee from clocking in while earning overtime, turn on
Restrict Clock In when employee reaches overtime.

Employees can also be restricted from clocking in after they earn a specified
number of hours.  Like the previous restriction, this only affects employees when
they are clocking in.

To restrict an employee from clocking in after a specific number of hours turn
on Restrict Clock In when employee reaches _X_ hours and enter the
appropriate number of hours in the text field.

Before any restrictions can take place, the appropriate passwords
must be set up.  Failure to set up the proper passwords will cause
the restrictions to be ignored by TimeClock Plus. Please see
Passwords p. 73 in the Reference Guide for more information.

You can send an employee a message the next time they clock in by
entering that message in the Employee Msg field.   If enabled in the defaults (see



20 TimeClock Plus Users Guide

p. 63) the message history is tracked on a per employee basis.  To view the
message history from this screen click on the History button.

Scheduler

To restrict employees from clocking in or out too far outside of their
scheduled time:

Select the types of schedule restrictions you want to use and enter the
amount of leeway.  If you want to prevent an employee from clocking in more
than 10 minutes late or leaving more than 10 minutes early without special
approval, check the box Late Clock In and enter 10 minutes.  Then you would
check the box Early Clock Out and enter 10 minutes.

In addition to restricting an employee’s clock in and out times to scheduled
times, their clock in and out times can also be rounded to their scheduled times.
Most often these restrictions are used together.  If you would like to prevent an
employee from clocking in more than 10 minutes early and rounding to their
scheduled time if within 10 minutes, you should set both the approval and round
to scheduled times to 10 minutes.

Employee schedule restrictions and rounding will not take place
unless a schedule exists for an employee for the current day.  To
verify a schedule exists, you can launch the scheduler or attempt
to view the employee’s schedule while clocking in/out from the on
screen TimeClock or RDT (see p. 33).   Restriction passwords
must also be set in order for restrictions to be active, but do not
need to be set for rounding to take place.

Notes

You can enter any other information you want to store about this employee
by clicking on the Notes tab and entering the information.

Photos

If you want to store the employees photo, click on the Photo tab, click New
Photo, click Locate, and find the file that stores the employee’s photo.  The
photos must be in a Windows .BMP format.  Internally, they are stored in the
PHOTOS subdirectory of the TimeClock Plus data directory.

Reviews

You can enter employee reviews by selecting the Reviews tab and
selecting New.  Enter the review date, the review time, a description
and the review notes.  To save enter Ok to delete enter Cancel.



TimeClock Plus Users Guide 21

Cumulative

There are no configurable options in this window, however there is useful
information about the employee’s accumulated hours.  These hours can be reset
on a company wide or employee basis by using the Reset Tracked Fields option
in the TimeClock Manager (See Reset Tracked Fields in the Reference Guide, p.
75).

You have now set up and completely configured your first employee.  Click
Add Another if you want to add more employees, or click Ok if you are finished
for now.

Adding schedules

One of the more sophisticated features of TimeClock Plus is its ability to
track employees according to a schedule.  You can restrict employees to the
schedule, track tardies and absences, and round to the schedule.  The program
that controls your schedule is the TimeClock Scheduler.  You can access
Scheduler from TimeClock Manager by using the Launch menu or by selecting it
from the TimeClock group on the Start Menu.

To set up an employee’s schedule:

 1) Launch TimeClock Scheduler.
 2) From the File menu, select New Schedule...
 3) Select the week for the schedule you want to create by using the Next

and Previous buttons or by clicking on a day within the week on the
calendar being displayed.

 4) If you have already created a similar schedule, click Yes at the Copy
Schedules dialog box and select the week you want to copy the week
from.  Otherwise, click No.

 5) From the View menu, select Employee Schedule.
 6) Enter the number of the employee whose schedule you want to edit.
 7) Double-click on one of the boxes under the day you want to schedule

the employee for.
 8) Enter the employee’s time in, time out, the job code under which he or

she will be working, and optionally a description of the shift in the
spaces provided.

 9) Click Ok.
 10) Repeat from step seven for each shift for this week the employee will be

working.
 11) Repeat from step five for each employee you want to schedule.

This process is only necessary once; in the future, you can copy this
schedule and modify it instead of having to create the schedule from scratch.
Just click Yes at the Copy Schedules prompt after creating a new week.

For more detailed schedule techniques refer to Necessary Shifts p. 87 in the
Reference section and Shift Pool p.86.
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Adding cost codes

With the optional Job Cost Module, employers can keep track of how much
time is being spent on individual work orders.  If you do not have the Job Cost
Module, you can skip this section.

If your cost codes are numeric, employees can enter them directly
at a remote data terminal, instead of scrolling through a list.

To add cost codes:

 1) Launch TimeClock Manager
 2) From the Configuration menu, select Master Cost Code List...
 3) Click Add.
 4) Enter a code for the cost code in the Cost Code box.  This can be up to

12 characters, and can consist of uppercase letters, numbers, and
symbols.

 5) Enter a description for the cost code in the Description field.
 6) Click Ok.
 7) If employees should be able to use this cost code, mark it Active.  Cost

codes that are active show up in cost code lists when employees are
clocking in or changing codes; cost codes that are inactive do not.

 8) Repeat from step 3 for all cost codes to be added.

To add a range of cost codes:

 1) Launch TimeClock Manager
 2) From the Configuration menu, select Master Cost Code List...
 3) Click Add.
 4) Click Range.
 5) Enter the starting and ending code in the appropriate fields.
 6) Click Ok.
 7) If the information is correct, answer Yes to continue, otherwise enter No

to cancel.
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 5.  The Remote Data Terminal

The TimeClock Plus Remote Data Terminal (RDT) is a device that allows
your employees to clock in and out at a location away from the computer.  It can
be purchased with or without a magnetic card reader.  The RDT must be
connected to a computer running the WinRemote software during operation.

Setting up the RDT

The RDT is not a stand-alone device; it has no memory or processing power
of its own.  A computer controls all of the RDT’s operations.  The RDT must
remain connected to the computer during use, although the computer can be
performing other tasks while the RDT is in use.

To connect the computer to the RDT, you must have a free serial port, or
COM port.  Modern computers have two styles of serial port:  DB9 and DB25
ports.  You can connect the RDT to either style of port, however you must have
the proper adapter.  Do not connect the RDT directly to an RJ11 port (telephone
port) on your modem; damage to both devices may result.

The RDT comes with an adapter to connect it to a serial port.  Connect one
end of the RJ11 cable (it looks like a telephone cable) to the adapter, and the
other end to the RDT.  Be sure that you are using the cable supplied by Data
Management.

Do not attempt to replace the cable supplied by DMI with a phone
cable!  Although the RDT cable and a phone cable look identical,
they are not interchangeable.

Also, for best results, do not run the RDT cable parallel to power lines, and
avoid ballasts like those found in fluorescent lighting whenever possible.

Configuring the WinRemote Software

WinRemote is the program that configures and runs the RDT.

To configure WinRemote:

 1) Run the WinRemote program.
 2) If you are unsure where the RDT is connected proceed to step 10.
 3) Click on the button for the serial port where your RDT is connected.
 4) Click Configure.
 5) Choose the options you want enabled from the displayed list.  If you

want the RDT to be automatically started the next time WinRemote is
started, be sure that the option Activate port on program start-up is
checked.
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 6) Click Ok.
 7) Click Start.
 8) Repeat from steps two through six for each port connected to an RDT.
 9) Installation is complete.
 10) Click on Locate to begin the RDT detection process.
 11) From the list of available ports, select the port where the RDT is

connected.
 12) Select Configure to configure the options for the selected port.
 13) Repeat steps 11 and 12 until all RDT’s are configured.
 14) Select Close to close the locate window.
 15) Exit and restart WinRemote to activate each of the ports that were

previously configured.
 16) Installation is complete.

To make the RDT’s activate when you start Windows, copy the WinRemote
icon to your Start-up group.  See the documentation that came with Windows for
details on how to do this.  (If logins are activated on your Windows installation,
the RDT will not activate until after you log in.)

Using WinRemote

The Activity Log

WinRemote keeps an activity log to let you view recent transactions on the
remote data terminal.  The log records a summary of each successful
transaction.

To view the activity log:

 1) Click on the radio button corresponding to the serial port that the RDT is
connected to, i.e. COM1:, COM2:, COM3:, etc.

 2) Click Activity.

The activity log is normally cleared when you reboot the computer or reload
WinRemote.  It can also be cleared manually.

To clear the activity log:

 1) Click on the radio button corresponding to the serial port to which the
RDT is connected.

 2) Click Activity
 3) Click Clear.

You can save the activity log to a text file for use with Notepad or another
text editor.  This writes the current contents of the activity log at the instant to the
file. It does not keep updating the log during operation.
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To save the activity log:

 1) Click on the radio button corresponding to the serial port to which the
RDT is connected.

 2) Click Activity.
 3) Click Save.
 4) Specify the path and filename for the saved log file.
 5) Click Ok.

Diagnostics

You can read the magnetic cards to see what is encoded on them.  With
WinRemote, this can only be performed if the option Allow mag card test with
00 is on for the specified port.

To test read magnetic cards:

 1) On the RDT, press 00.
 2) Swipe the magnetic card.  Read the displayed number, then press any

key.
 3) Repeat from step two, or press Esc to end the test.

You can also see which port an RDT is connected to, and how long it has
been running.  With WinRemote, this can only be done if the option, Allow ID
terminal with 11, is activated for the specific com port.

To check an RDT’s port and uptime:

 1) On the RDT, press 11.
 2) Read the displayed port and uptime.

Connecting to a Time Server from WinRemote

From the WinRemote configuration screen select Time Server.  From this
window you have a choice of disabling or enabling the Time Server.

To Enable the Time Server:

 1) Click on the button Time Server Enabled.
 2) Enter the name or IP address (in the form XXX.XXX.XXX.XXX) where

the Time Server can be found on your local network.

Prior to configuring client  computers to connect with a Time Server, the time
server application should be configured.  See the “Time Server Application”
section in this guide, p. 27.
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Troubleshooting the RDT

The following list defines common problems and solutions encountered
during the setup of the Remote Data Terminal.

Problem Possible Solutions

RDT does not have a flashing
cursor in the upper corner when
power is applied.

Check to ensure that all connections are
secure from the power outlet to the RDT.
Try moving the RDT to an outlet that is
known to be functioning properly.

When the software is running for
the RDT, the menu appears, but
none of the keys on the RDT
work.

The most common cause of this is a
reversed cable.  Although a telephone cable
looks like the cable that is shipped with the
RDT, they are not interchangeable.  Make
sure that you are using the original cable
that came with the RDT.  If you are using a
long cable, try moving the RDT close to the
PC and using a short cable to ensure that
the cable is not the problem.

When the software is activated,
the RDT had power but nothing
will appear on its display.

Check all connections from the PC to the
RDT.  No gender changers are required to
connect the RDT to the back of the PC.  The
RDT connector is a female connector and
should plug directly into a 9 pin or 25 pin
male serial port on the back of your PC.  You
should be using a connector provided by
Data Management and not a 9 pin to 25-pin
converter or any standard over the counter
connector.

RDT or setup software freezes
when I attempt to locate the
RDT(s) attached to my system.

This can happen when you have COM ports
in your system that are not configured
properly.  For example, if you have a modem
that is set to COM3 using IRQ 5, but
Windows has the modem set at COM3 using
IRQ3, the initialization of the port may hang.
Correct the problem from the Control Panel
within Windows using your Windows
documentation.

When I activate the RDT, the
software randomly changed from
Clocking In to Waiting.

This is commonly due to starting the RDT on
a COM port that contains a modem.  Stop
the RDT software and locate another COM
port to use.
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6.  The Time Server Application
The Time Server application is designed to be run on a network providing

both TimeClock Plus and the RDTs with the system time on the server.  This
application is only available in the network version of TimeClock Plus.  This
allows all clients and RDT’s to be time synchronized.  There are two versions of
the time server application.  Both are installed in the TimeClock directory when
the software is installed.  The first version named “TIMESVR.EXE” is a stand-
alone application that is designed to be run from the desktop or startup folder.
Users must be logged in, to run this application.  The second method is named
“TIMESV32.EXE” and it runs as a service on Windows NT platforms only.

In order to run any of the Time Server software, your network
must be configured to run TCP/IP.   If you are unsure if TCP/IP is
configured on your network, consult your network administrator.

Stand alone Time Server

You may want to setup this application in the startup folder to ensure that it
is run automatically when the user logs in.

 1) Login to the system on which you will be running the Time Server.
 2) From the TimeClock Plus group launch Time Server.

Time Server Service on Windows NT

On systems running Windows NT the Time Server is run as a service.  A
service is an application that is started in the system without the need for a user
to log in and manually start it.

To configure the Time Server application on an NT system:

 1) Log onto the Windows NT system as Administrator.
 2) From the TimeClock Plus folder in the Start Menu launch Time Server

Configuration.
 3) Examine the status of the Time Server application.  If it is installed and

running, skip to step 6.  If the server is installed and stopped skip to step
5.

 4) Click on Install Service to install the service into the NT service
database.

 5) Click on Start Service to start the service.
 6) The service is now running and time can be obtained from this computer

by specifying its name or address in the client setup of each of the
TimeClock applications.

Once the Time Server is running, refer to the individual applications
WinRemote and TimeClock32 to configure the Time Server for each client
workstation.
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7.  TimeClock Operation
TimeClock Plus provides two ways for employees to clock in and out.

Employees can use the TimeClock Plus program to clock in and out at a
computer running Microsoft Windows 3.1, 95, 98 or NT.  If a computer is not
accessible to the employees, they can use a Remote Data Terminal (sold
separately) to clock in and out at a separate location, connected to a computer
running Microsoft Windows 95, 98 or NT.

Using TimeClock Plus from the PC

TimeClock Plus is simple and intuitive to use.  Most of the prompts are self-
explanatory.  TimeClock Plus allows users to clock in from their PC keyboard.

Clocking In

To Clock In:

 1) Click Clock In.
 2) Enter your employee number and click Ok.
 3) If necessary, check the following screen to ensure that your name

appears and press Yes or No as appropriate.  If you want to view your
hours so far for the week, your schedule or your last transaction, click
the appropriate button on the right of the screen.  These options must
be enabled from the TimeClock Defaults.

 4) If you can clock in under multiple job codes, click on your job code for
this shift and click Ok.

 5) If you use cost codes, click on your cost code for this shift and click Ok.
 6) If you have a personal message read it and click Yes or (No if you want

the same message to appear next time you make a transaction).
 7) If a management message is displayed, read it and press a key.

Clocking Out

To Clock Out:

 1) Click Clock Out.
 2) Enter your employee number and click Ok
 3) Check the screen to ensure that your name appears.
 4) If the job code you had been clocked in under requires you to enter tips

or another tracked field, enter that and click Ok.
 5) If you have a personal message, read it and press Yes or No.
 6) If a management message is entered, read it and press any key
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Changing Job Codes

To Change Job Code:

 1) Click Job Code.
 2) Enter your employee number and click Ok.
 3) Check the screen to ensure that your name appears.
 4) Click on your job code for the next shift and click Ok.
 5) If necessary, enter the tips earned on the previous shift and press

Enter.
 6) If you use cost codes and they are enabled for the current employee,

click on your cost code for this shift and click Ok.
 7) If you have a personal message, read it and press Yes or No.
 8) If a management message is entered, read it and press any key.

 Changing Cost Codes (Additional Module Required)

To Change Cost Code:

 1) Click Cost Code.
 2) Enter your employee number and click Ok.
 3) Check the screen to ensure that your name appears.
 4) Click on your cost code for the new shift and click Ok.
 5) If you have a personal message, read it and press Yes or No.
 6) If a management message is entered read it and press any key.

Viewing and verifying hours

To View Hours:

 1) When clocking in or out, click on View hours.
 2) Move your cursor to the left of the hours you want to verify (under the

Ok column) and Click your left mouse button.  This puts a check mark
next to those hours indicating your verification of those hours.

Using TimeClock Plus on a Network.

The network version of TimeClock Plus has the ability to connect to a time
server to obtain the time from a computer other than the local computer.  This will
prevent clock in and out times that vary depending on the computer time of the
client machines.

Prior to configuring TimeClock Plus to connect to a time server, you must
have a valid time server running on your network.  Refer to the “Time Server
Application” section on page 27 in this guide for directions on configuring a Time
Server on your network.
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To configure the time server settings:

 1) Launch TimeClock Plus from the TimeClock program group.
 2) Click on the windows System Menu in the upper left corner of the

window.
 3) From the list of options choose Configure.  If you have a supervisor

password setup, you will be prompted to enter it in order to view/change
the time server settings.

 4) Click on the Time Server tab to see the following screen.

 5) Click on Time Server Enabled, and enter the server name or IP
address in the box specified.

 6) If you want to force the time to be obtained from a Time Server, remove
the check from the box marked “Allow clock operations when time
server cannot be contacted.”

 7) If you would like the specified time server to be the default for all clients
on your network, click the box labeled, “Save as default server for all
clients”.  If this box is not checked, each PC on the network will have to
be configured individually.  This can be useful if you want to connect to
two separate time servers.

 8) Click Ok and setup is complete.  If you have changed the value of the
server in the setup, you will be prompted to reconnect to the new time
server.  If you would like to connect, choose Yes.

Using the Remote Data Terminal

The Remote Data Terminal or RDT, is the most convenient way for
employees to clock in and out.  It allows them to clock in and out without needing
a computer, mouse, or other bulky items present.

When the RDT is not in use, it will display a title screen that includes the
available options.  If the option Display system time on terminal is activated,
the RDT will also display a clock showing the computer’s current time.
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Clocking In

To Clock In on the RDT:

 1) Press Clock In.
 2) Enter your employee number and press Enter, or swipe your magnetic

card.  You should swipe the card with the magnetic stripe away from the
display on the right hand side of the terminal.

 3) If necessary, check the screen to ensure that your name appears and
press Yes or No as appropriate.  If you are using a magnetic card, this
will only be necessary if the option Confirm name on mag card swipe is
turned on.

 4) If you can clock in under multiple job codes, punch in your job code for
this shift and press Enter, or press ‘.’ to view a list of available job
codes.

 5) If you use multiple cost codes, punch in your cost code for this shift (if it
is numeric), or press Clock In and Clock Out to cycle through a list of
available codes.

 6) If a management message is entered, read it and press any key.
 7) If you have a personal message, read it and press Yes (or No if you

want the same message to appear next time you make a transaction).
 8) If the option Confirm successful clock in/out is on, then a brief message

will appear to tell you that the transaction is successful.

Clocking Out

To Clock Out on the RDT:

 1) Press Clock Out.
 2) Enter your employee number and press Enter, or swipe your magnetic

card.
 3) If necessary, check the screen to ensure that your name appears.
 4) If the job code you had been clocked in under requires you to enter tips

or another tracked field, enter that and press Enter.
 5) If a management message is entered, read it and press any key.
 6) If you have a personal message, read it and press Yes or No.
 7) If appropriate, a brief message will appear to tell you that the transaction

is successful.

Clocking Out on Break

To Clock Out for Break on the RDT:

 1) Press Break.
 2) Enter your employee number and press Enter, or swipe your magnetic

card.
 3) If necessary, check the screen to ensure that your name appears.
 4) If necessary, enter the tips earned this shift and press Enter.
 5) If a management message is entered, read it and press any key.
 6) If you have a personal message, read it and press Yes or No.
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 7) If appropriate, a brief message will appear to tell you that the transaction
is successful.

Changing Job Codes

To Change Job Codes on the RDT:

 1) Press Job Code.
 2) Enter your employee number and press Enter, or swipe your magnetic

card.
 3) If necessary, check the screen to ensure that your name appears.
 4) Punch in your job code for the next shift and press Enter, or press

Period to cycle through a list of available job codes.
 5) If you use multiple cost codes, punch in your cost code for this shift or

press Clock In and Clock Out to cycle through a list of available codes.
 6) If necessary, enter the tips earned on the previous shift and press

Enter.
 7) If a management message is entered, read it and press any key.
 8) If you have a personal message, read it and press Yes or No.
 9) If appropriate, a brief message will appear to tell you that the transaction

is successful.

Changing Cost Codes

To Change Cost Codes on the RDT:

 1) Press Job Cost.
 2) Enter your employee number and press Enter, or swipe your magnetic

card.
 3) Select the new cost code and press Enter.
 4) If appropriate, a brief message will appear to tell you that the transaction

is successful.

Checking Hours

Employees can check their hours for the current shift and current week from
the RDT if the option is enabled in the defaults screen in TimeClock Manager
(see p. 63).

To check hours from the RDT:

 1) Press the Clock In or Clock Out button.
 2) Enter your employee number when prompted.
 3) When your name is displayed on the screen with the yes/no

confirmation, press the 0 (zero) key on the keypad.
 4) Press the No/Esc key to return to the main screen.

Viewing last punch

Employees can view their last punch from the RDT if the option is enabled in
the defaults screen in TimeClock Manager (see p. 63)
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To view last punch from the RDT:

 1) Press the Clock In or Clock Out button.
 2) Enter your employee number when prompted.
 3) When your name is displayed on the screen with the yes/no

confirmation, press the 8 key on the keypad.
 4) Press the No/Esc key to return to the main screen.

Viewing schedules

Employees can view the schedule for the current week and the next week
from the RDT if they are allowed in the system defaults.

To view a schedule from the RDT:

 1) Press the Clock In or Clock Out button.
 2) Enter your employee number when prompted.
 3) When your name is displayed on the screen with the yes/no

confirmation, press the period key on the keypad.
 4) When prompted select 1 or 2 to view this week or next weeks schedule.
 5) Press the Yes/Enter button to cycle through the schedule or press the

No/Esc button to Quit.

Editing hours

TimeClock Plus has the ability to edit employee hours from the
RDT.  In order for this option to be active it must be enabled from the
TimeClock defaults screen in TimeClock Manager.   In addition, any
user that must have access to editing hours from the RDT should be added to
the TimeClock user list and granted access to this feature.

To Add Clock In or Edit Clock Out :

 1) Press 6 on the keypad
 2) Press the Clock In or Clock Out keys to select your user ID.
 3) Enter your RDT password and press Enter.
 4) Enter employee number and press Enter.
 5) Select option 1
 6) Use the Period key and the Enter key to scroll to the number you want

to change.
 7) Press Enter
 8) Enter Job code and press Enter.
 9) Enter Cost code (requires Job Cost Module) and press Enter.
 10) Press Esc to escape out of the Edit mode.

To Add Hours:

 1) Press 6 on the keypad
 2) Press the Clock In or Clock Out keys to select your user ID.
 3) Enter your numeric password and press Enter.
 4) Enter employee number and press Enter.
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 5) Select 2, Add Hours
 6) Use the Period key and the Enter key to scroll to the number you want

to change.
 7) Press Enter
 8) Enter Job code and press Enter.
 9) Enter Cost code (requires Job Cost Module) and press Enter.
 10) Press Esc to escape out of the Edit mode.

To Edit Shift:

 1) Press 6 on the keypad
 2) Press the Clock In or Clock Out keys to select your user ID.
 3) Enter your RDT numeric password and press Enter.
 4) Enter employee number and press Enter.
 5) Select 3, Edit Shift
 6) Press the Clock In or Clock Out keys to scroll through the shifts until

you find the one you want to edit.
 7) Press Enter.
 8) Use the Period key and the Enter key to scroll to the number you want

to change.
 9) Press Enter
 10) Enter Job code and press Enter.
 11) Enter Cost code (requires Job Cost Module) and press Enter.
 12) Press Esc to escape out of the Edit mode.
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8.  Printing Reports
TimeClock Plus has the ability to print a variety of reports for different

purposes.  These reports can range from time sheets to schedules to detailed job
code analysis reports.  Both TimeClock Manager and TimeClock Scheduler have
the ability to print reports.

The Pay Period reports are the majority of the reports produced by
TimeClock Plus.  Most of the reports you will be printing will be pay period
reports.  Except as noted these reports can be printed for a maximum timespan
of one month.

To print pay period reports:

 1) Launch TimeClock Manager.
 2) From the Reports menu, select Pay Period.
 3) Select the period you want to print, then from the displayed list, select

the reports that you want to print.
 4) If you want to only print certain employees, click Criteria and enter the

criteria for the employees you want to include.  See Criteria in the
Reference Guide, Page 62.

 5) If you want to specify certain optional features of the reports, click on
Options and select the appropriate options.  These options are detailed
in the descriptions of the reports.

 6) Click Print.
 7) If you want to preview the reports before printing, turn on View on

screen before printing.  The Windows printer driver handles other speed
vs. quality and resolution decisions.  See your Windows documentation.

 8) If you want the reports to be printed with emphasis on print speed, turn
on Draft mode.  If you would rather emphasize print quality, turn off
Draft mode.

 9) If you need to configure the printer, for example to use a different printer
or to print in a different resolution, click Setup Printer and set up the
appropriate options.

 10) Click Ok.

To get a more detailed description of a report, place the mouse
cursor over the report title in the tree list and press the right
mouse button.

Pay Period Report Options

To edit the report options, click the Options button from the pay periods
report screen.
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Overall

Print salaried employees If this option is cleared, employees with
the Salary option (under the Overtime
tab of the employee edit screen)
marked will not print.

Print employee wages If this option is checked, the wages
entered in the Job Code tab of the
employee edit screen will print.

NOTE: The current user must have
access to wages in his/her user profile.

Report Saturday/Sunday hours This option will include an additional
field on hours worked on Saturday
and/or Sunday.

Print hours worked in hours:minutes This determines whether hours and
minutes or hours and hundredths are
used to report hour totals.  If this option
is checked, then seven hours and
fifteen minutes will be printed as 7:15.
If this option is cleared, then it will be
printed as 7.25.  Note that due to
rounding limitations mathematically
inherent in this conversion, the
hours/hundredths method may cause
totals to appear incorrect.  However,
the information is correct and
mathematically sound.

Example:  Three shifts of six hours
and 20 minutes will report, in
hours/hundredths, as 6.33 hours each
(6 1/3 hours each).  Adding these up
manually will result in 18.99 hours,
when the actual time is 19 hours.
TimeClock plus will print 19.00 hours in
this case.

If you aren’t sure what was printed at a
particular time, remember that a colon
( : ) means that hours:minutes was
used, and a period ( . ) means that
hours/hundredths was used.

When viewing reports printed in
minutes, remember that 1:30 (one hour
and thirty minutes) plus 1:30 is equal to
3:00 because 1 1/2 hours plus 1 1/2
hours is equal to 3 hours.  If the reports
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were in hundredths, they would print as
1.50 (1 and 5/10 of an hour) hours plus
1.50 hours equal 3.00 hours.

Spacing This determines the amount of space
between the lines of text.  The smaller
this value, the closer together the lines
are printed.  Valid entries are from 1.0
to 3.0.

Print employee code/number/neither Determines whether the number
printed to identify the employee is the
TimeClock Plus ID number, payroll
code, or if no number is to be printed.

Sort reports according to Determines how to sort the reports.
Due to the nature of some reports, they
may not be printed in the selected
order.

Font sizes This feature allows you to control the
font size for your reports.  The options
include using the same font size for all
reports (136CPL), using the maximum
font size that will fit on the page, and
using an auto font size for each report.

Misc

Payroll Summary Determines how the payroll summary
report will be printed.  It can be
subdivided into job codes and rates.

Supplemental Pay Calculations Determines if overtime is included
when calculating supplemental pay.
The minimum wage can also be
entered to determine the amount an
employee is short of earning minimum
wage.

Complete Payroll Determines if a signature line and job
code break down prints on the
complete payroll report.

Schedule

Schedule vs. Actual Determines what sections are printed
on the schedule vs. actual report.  At
least one must be chosen for this
report to print.

Absent and Tardy Information Enter the number of minutes a person
must be late to be considered tardy
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and absent.  If you want to use the
actual times instead of the rounded
times when determining absent and
tardy, place a check in the appropriate
box.

Orientation

Orientation Report List Determines how each of the reports
will print.  Normally all reports will print
in portrait mode.  If you would like to
print reports sideways on a page,
select landscape for the report.

Pay Period Reports

Complete Payroll

The Complete Payroll report consists of one page for each employee,
detailing each shift, breakdowns into overtime, totals for each week and for the
entire pay period, and (optionally) lines for the employee and manager’s
signatures.

Day Breakdown Report

This report prints out a single line for each employee, showing the
employee’s number, name, social security number, how many hours were
worked for each day of the week, and how many hours were worked on holidays.

Employee Job Report

This report is broken down first by employee, then by job code.  It shows the
number of hours, broken into regular and overtime, the tips, and hourly rate for
the period specified.

Estimated Wages Report

This prints out a report broken down first by employee, then by job code.  It
shows the number of hours (regular and overtime), the pay rate worked for each
job code, and the estimated wages due this employee (without any sort of taxes
or deductions).
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Job Code Analysis (Detail)

This report prints out, broken first by job code then by employee (with totals),
the number of regular and overtime hours worked, with an estimate of wages.

Job Code Analysis (Summary)

This report is broken down by job code only.  It prints out the number of
regular and overtime hours and total wages for each job code.

Payroll Summary

This is broken down first by employee, then by job code (with totals), then by
week (with totals).  It indicates the pay rate, regular hours, overtime hours, and
the number of tips (only on per job code totals).

Period Report

This report is broken down first by employee, then by week (with totals).  It
prints out the number of total hours, regular and overtime hours, sick and
vacation time, and tips.  The Period Report can be printed for a timespan of up to
10 years.

Supplemental Pay Report

The Supplemental Pay Report adds up wages and tips, compares the sum
to the appropriate minimum wage for the time accumulated, and indicates if there
is any shortage.

Minimum wage is set in the Options under the Misc tab.

Tracked Field Report

This is broken down by employee, then by job code (with totals), then by
week (with totals).  It indicates the tips earned during each week.

Weekly Punch Report

This is a detailed report of each transaction, indicating date and time in and
out, job code, break length (with p for paid or u for unpaid), and hours worked.  A
bracket marks entire shifts.

Absent Report and Tardy Report

These print out the employees who were absent or tardy during the selected
period, the dates they were absent or tardy, and the times they were scheduled
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to work.  There must be a schedule set up before printing this report; see Adding
Schedules, p21.

The option- An employee is officially absent when _X_ minutes late and
An employee is officially tardy when _Y_ minutes late under the Summary
tab, set how late an employee can clock in before TimeClock Plus considers him
or her tardy or absent.  These reports cannot be printed for the current day.  For
information on how to print the current day’s information, see Who’s Here in the
Reference Guide, p 81.

Job Scheduled versus Actual

This is actually two separate reports in one.  The reports can be selected in
the Schedule vs. Actual box under the Schedule tab.  The first, printed only if
the option Include employee detail is on, breaks down the information first by
employee, then by job code.  The second, printed only if the option Include
employee per job detail is only broken down by job code.

Each report includes information for the time scheduled, actual time earned,
and the difference.  For each of these, the report includes number of regular,
overtime, and total hours and estimated wages.  The report can be printed only
for weeks that have been closed.

Anniversary Report

This prints out employees who have anniversaries with the company in the
time requested.  This report can be printed for a maximum timespan of one year.

Example: Fred Bloggs joined the ranks of Dr. Wilson’s Computer Services
on April 1, 1990.  In a report to print out all anniversaries in April 1999, a line will
be included stating that he has been with the company nine years as of April 1,
1999.

Birthday Report

This prints out the date of birth and age of employees who have birthdays in
the time requested.  This report can be printed for a maximum timespan of one
year.

Cost Code Summary (requires Job Cost Module)

This is broken down by cost code (with totals), then by job code (with totals),
then by employee.  It displays the number of regular and overtime hours worked,
and an estimate of wages paid.
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Individual Cost Summary (requires Job Cost Module)

This is broken down by employee, then by cost code (with totals), then by
job code.  It displays the number of regular and overtime hours worked, and tips
accumulated.

Individual Costing Report (requires Job Cost Module)

This report prints out a separate page for each employee.  It displays each
shift, time in, the time out, the cost code, the job code, pay rate, tips earned, and
hours worked.  Optionally, it can display a summary of each cost code.

Job Cost Analysis (requires Job Cost Module)

This is broken down by cost code, then by job code. It displays the number
of regular and overtime hours worked, and an estimate of wages paid.

Period Job Cost Report (requires Job Cost Module)

This report prints out a separate page for each cost code.  It is broken down
by employee (with totals), then by week (with totals).  It displays the number of
regular, overtime, sick and vacation hours, and tips earned.  This report can be
printed for a maximum timespan of 10 years.

Other TimeClock Manager reports

Although the Pay Period reports are by far the most common, TimeClock
Manager has several other reports for various purposes.

Approaching Overtime

This report prints out employees who are near overtime or (for salaried
employees) employees who are near a specified number of hours.

To print the Approaching Overtime report:

 1) Launch TimeClock Manager.
 2) From the Reports menu, select Approaching Overtime....
 3) If you want to print employees who are approaching weekly overtime,

turn on Employees Earning Weekly Overtime and enter the number of
minutes of leeway you want to provide.

Example: Mary Bloggs earns overtime after 40 hours per week.  She
has worked 38.5 hours so far this week.  A report printed with 120
minutes of leeway would include her in the list of employees
approaching overtime.  A report printed with 60 minutes of leeway would
not.
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 4) If you want to print employees who are approaching daily overtime, turn
on Employees Earning Daily Overtime and enter the number of
minutes of leeway you want to provide.

 5) If you want to print salaried employees who have exceeded a specific
number of hours this week, turn on Employees who are Salaried and
enter the number of hours that you want the employee to have work
before they are added to the list.

 6) If you only want to include certain employees, click Criteria and specify
the employees you want to include.

 7) Click Print.

Employee Job/Rate Report

The Employee Job/Rate Report indicates the pay rates and last rate change
of each employee.

To print the Employee Job/Rate Report:

 1) Launch TimeClock Manager.
 2) From the Reports menu, select Employee job information....
 3) Check the boxes corresponding to the items that you want included on

the report.
 4) If you want to only print particular employees, click Criteria.  Select the

employees you want to include.
 5) Click Print.

Employee list

This list can print various information about the employees, such as address,
date of birth, etc.

To print the employee list:

 1) Launch TimeClock Manager.
 2) From the Employee menu, select Print Information....
 3) The fields in the list on the right are printed.  The fields in the list on the

left are not.  To move a field from one box to the other, double-click on
it.

 4) Check the number in the Space Available box.  If this reads “None”,
then the text will be shrunk to accommodate the printed page.

 5) If you only want to print certain employees, click Criteria and enter the
criteria for the employees you want to print.

 6) Click Print.

Scheduler reports

The Scheduler provides many reports to help analyze the schedules.  All
scheduler reports operate on schedule data only; they do not work with any
actual clock in/clock out records.  These reports can be printed for a maximum
timespan of one week.
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To print scheduler reports:

 1) Launch TimeClock Scheduler.
 2) From the Reports menu, select Print Scheduler Reports.
 3) Select the reports you want to print.
 4) If you only want to print certain employees, click Criteria, and enter the

criteria for the employees you wish to print.
 5) If you want to change the options that control the reports, click Options

and edit the options as appropriate.
 6) Click Print.

Depending on the reports you selected you may be prompted for several
parameters.  These are discussed in the descriptions of the reports.

Daily Schedule

This prints out, sorted by time in, a list of all shifts for each day.

Daily Visual Schedule

This prints out a daily schedule in a graphical format.  Times are not shown;
instead, the day is presented across the page, with each employee on one line
and a bar through the times they are scheduled to work.

Individual Schedule

This prints out a complete schedule, showing each day’s shifts for all
selected employees.

Job Code Schedule

This prints out, for a particular job code, a list of who is scheduled to work
that job code.  This is printed one page per day, and sorted by time in.

Weekly Schedule

This prints out a list of all employees and the days of the week, showing
each shift they are scheduled to work each day, with a space for each
employee’s initials.  This schedule is suitable for display.

Necessary Shifts and Necessary Shifts with Assignments

For information on necessary shifts, see the Reference Guide, p. 87.  This
prints out a list of all assigned necessary shifts and, optionally, the employees
assigned to these shifts.  The sort order can be changed in the Options screen.
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Time Coverage Report

This report prints a graph showing, in fifteen minute increments, how many
employees are scheduled to work during a specified time range.

Print Setup

If you need to use a different printer or different printer settings than the
default, you can use the Print Setup option.  This lets you select your printer and
your driver settings.

To configure a printer, select Print Setup... from the File menu.  The
specifics of how to change your printer settings will vary from printer to printer.
See your Windows documentation or your printer driver’s documentation for
details.
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9.  Maintaining TimeClock Plus

Editing hours

Sometimes, special changes have to be made to the records.  Employees
need sick time to be added, or forget to clock in, or other such items.  TimeClock
Plus provides special facilities to edit employees’ records in these cases.

To view an employee’s hours in TimeClock Manager, from the Employee
menu, select Edit Employee Hours....  If you need to edit hours for a week that
has been closed, you must first select View previous saved week... from the
File menu, and select Return to current week from the File menu after you’re
finished.

History information such as cumulative hours worked is not
updated when you edit previous weeks.  For this reason it is
recommended that all editing take place before the week is closed.

In this figure the employee has worked three shifts this week.   On 1/18, he
worked from 8:45 AM until 3:00 PM in job code 101.  He entered $15.00 in tips
for this shift. He also worked from 9:05 AM until 3:12 PM on 1/19.  He clocked in
at 8:55 AM on 1/20 and is still clocked in.  Both the employee and the manager
have verified his first shift, and the employee has verified the second shift.

From this screen, you can add, delete, or modify individual records, and you
can combine records to form shifts.

To add or modify a record:

 1) If you want to add a new record, click Add.  If you want to edit an
existing record, double-click on the line you want to edit.

 2) Fill in the appropriate information for date and time in.
 3) Select the job code the employee works under for this time.
 4) Verify that the rate indicated is correct.
 5) If this employee uses cost codes, select the cost code the employee

works under for this time.
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 6) If the employee is still clocked in, turn on the Clocked In check box and
skip to step 10.

 7) Turn off the Clocked In check box.
 8) Fill in the appropriate information for date and time out.
 9) If the job code this employee is working under requires tips entry, enter

the appropriate amount in the Tips box.
 10) Click Ok.

To delete records:

 1) Click on the record you want to delete.
 2) Click Delete.

To combine records into shifts:

 1) Click on the first record you want in the shift.
 2) Click Break.
 3) Repeat for each record you want in the shift except the last record.

In order to maintain accountability, any edits made to employees’ hours are
permanently logged.  For each edit, TimeClock Plus records the date and time
the change was made, a description of the change, and the user who performed
the change (see User Profiles in the Reference Guide, p. 79).  This log can be
viewed by selecting, from the Tools menu, the option View hour edit log.

The times shown in the edit hours screen are the times for which
the employee will be paid.  If auto rounding or round to schedule is
active for the employee, these times may not be the actual in or out
time.  If it is necessary to view the employees actual times, click on
Also Show Actual Times and the screen will display the actual clock in and out
times if they vary from the time displayed.

Closing weeks

TimeClock Plus organizes its historical data in weeks.  The current week file
is the workspace where all transactions are performed.  For each previous week,
there is a separate file kept in an archival location.

Closing the week performs the process of archiving old data.  This takes all
the information that needs to be archived, and sends it to that week’s file.

The process of closing a week must be performed once every week.  No
data is lost, only stored in a different place.  Reports printed for time periods
outside the current week automatically access the appropriate archive file.  With
a mechanical timeclock, the manager will collect the timecard every week and
replace them with new ones.  TimeClock Plus performs a similar operation when
the week is closed.
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No matter how long your pay period is, or how often you print reports,
you MUST close the week, EVERY week.

You don’t need to close the week exactly at the end of the week.  TimeClock
Plus has a built-in one-week leeway period, during which you can edit your data
if necessary.  You can wait for that extra week and suffer no ill effects; however,
after that week, employees will be unable to clock in or out until the week is
closed.

Backing up your data is recommended prior to closing the week.  In the
event of a power loss or other problem during the close week procedure,
data can then be recovered. See Backing up your system in the Reference
Guide, p. 60.

To close the week:

 1) Launch TimeClock Manager.
 2) From the File menu, select Close current week....
 3) Confirm the information shown on the box displayed, then click Yes to

proceed.

Editing Employees

TimeClock Plus provides several facilities to edit employee records over
time, and quickly modify several employees.

To edit an employee’s record:

 1) Launch TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the employee number of the employee you wish to edit.  If you

aren’t sure, click “...”.  A list of all employees will appear, sorted by last
name.  If you want to sort the list by another method, double-click on the
column you want to sort by.

 4) Click on the tab that holds the information you want to edit.
 5) Edit the information in the normal manner.  The meaning of the items is

covered in the next section.
 6) If you want to edit the next employee, click >>.  If you want to edit the

previous employee, click <<.  If you want to edit a completely different
employee, click Goto and enter the employee’s number.  If you are
finished editing employees, click Ok.  If you want to save your changes
to this employee but keep the record showing, click Apply.

To add a new record:

 1) Launch TimeClock Manager.
 2) From the Employee menu, select Add....
 3) Enter the employee number of the employee you want to add.
 4) Click on the tab that holds the information you want to edit.
 5) Edit the information in the normal manner.  The meaning of the items is

covered in the next section.
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 6) If you want to add another employee, click Add Another.  If you are
finished adding employees, click Ok.  If you want to save your changes
to this employee but keep the record showing, click Apply.

Note that if you are adding several employees with similar information, you
can set up a template.  The employee template is used as the default information
when new employees are added.  The template has no effect on employees who
have been added before the template is set up.

To set up a template:

 1) Launch TimeClock Manager.
 2) From the Employee menu, select Template....
 3) Click on the tab that holds the information you want to edit.
 4) Edit the information in the normal manner.  The meaning of each item is

covered in the next section.
 5) Click Ok.

To delete an employee:

 1) Launch TimeClock Manager.
 2) From the Employee menu, select Delete....
 3) Enter the number of the employee you want to delete.
 4) Click Ok.
 5) Ensure that the name shown in the dialog box is the name of the

employee you want to delete.  If not, click Cancel.
 6) Click Delete.

When an employee is deleted, their information is permanently
removed from all of the TimeClock files and will not be accessible.

To change an employee’s number:

 1) Launch TimeClock Manager.
 2) From the Employee menu, select Move Employee.
 3) Enter the current number of the employee you want to move, then click

Ok.
 4) Enter the new number you want to assign this employee.
 5) Click Process Move.

A status box will appear to show you the progress of the move and to inform
you of any errors.

TimeClock Plus tracks many details about each employee.  The following
table discusses each of these options.
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Info

First name, Last name Both fields are mandatory

Address, City, State, Zip, SSN,
Birthdate, Phone, Race, Sex

These are for your reference and are
optional.

Employee Code This is the code used by your payroll
package to identify the employee.

Date Hired This is used to identify the date the
employee is hired.  It is also used to
determine anniversary dates in the
Anniversary Report.

Date Left If a date is entered here, the employee will
not be able to clock in after this date.  See
Restrictions in the Reference Guide.

Classification This is used to divide your employees for
reporting purposes.  See Classifications
and Criteria in the Reference Guide.

Custom Fields These fields can be configured to whatever
purpose you may desire from the
TimeClock Defaults.  See Defaults p. 63
and Criteria p. 62 in the Reference Guide.

Suspended An employee who is marked as suspended
will not be allowed to clock in or out and will
not appear on most lists.

Job Costing Enables cost codes for this employee.

Jobs

Code This lists the number for each department
or position under which this employee is
allowed to work.  See Job Codes in the
User Guide p. 4.

Description Displays the description of the job code.
This is taken from the description that was
entered in the Master Job Code List.

Rate This is the default pay rate entered for the
selected job code.  If the current user does
not have access to rates, asterisks will be
displayed.

Clockable This specifies whether or not an employee
may clock in and out under this code.  If
this is set to No, hours for this job code
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must be manually entered.

Earns Overtime (Eovt) This indicates whether an employee earns
overtime while working this job code.

Counts Toward Overtime (Covt) This indicates whether an employee’s
hours earned working under this job code
count toward the number of hours required
to reach overtime.  For example, if an
employee works 35 hours that count
toward overtime, 8 hours that do not, then 6
more that do, the employee will earn 1 hour
of overtime.  Job codes such as Sick and
Vacation usually do not count toward
overtime.

Tracked Field (Tips, etc.) This indicates whether or not an employee
will be required to enter a value for the
tracked field when clocking out from a shift
under this job code.

Overtime

Weekly Overtime This activates overtime after a specified
number of hours in a week.

Daily Overtime This activates Overtime #1 after a specified
number of hours in a day and Overtime #2
after a different number of hours.

Best of Weekly vs. Daily This selects, on an employee by employee
basis, whether Weekly or Daily overtime
would be more beneficial for the employee.
The choice is made by comparing the
wages earned for the week under each
type of overtime calculation.

Bi-Weekly Overtime This activates overtime after a specified
number of hours in a two week period.

NOTE: This is not the same as a bi-weekly
pay period where overtime is calculated on
a weekly basis for each of the two weeks in
the pay period.

Best of Bi-Weekly vs. Daily
Overtime

This selects, on an employee by employee
basis whether Bi-Weekly or Daily overtime
would be more beneficial for the employee.
This choice is made based on the entire
two week period.

Salaried or Set Amount of Pay This indicates that the employee is salaried
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and TimeClock Plus does not perform wage
calculations.

Both Daily and Weekly Overtime This activates overtime anytime the daily or
the weekly overtime requirements are met.

Overtime #1 This indicates the ratio of overtime pay to
regular time pay.  For time and a half the
value would be “1.5”.

Overtime #2 This indicates the ratio of overtime pay to
regular time pay.  For double time the value
would be “2.0”.

Accrual

See Accruals p.57 in the Reference Guide.

Restrictions

Auto Rounding This causes all clock in and clock out
times to be rounded to a multiple of the
time value specified.  Breaks are not
affected.

Example:  Fred Bloggs is set to round
clock in and clock out times to the
nearest 15 minutes, and to round up at
the eighth minute.  He clocks in at
7:52a; since that is seven minutes after
7:45a, he is marked as clocking in at
7:45a.  He then clocks out that evening
at 5:08p, since that is eight minutes
past 5:00p, he is marked as clocking
out at 5:15p.

Restrict Clock In when employee
reaches overtime.

This prevents an employee from
clocking in after the requirements for
overtime are met.  See Restrictions in
the Reference Guide, p.75.

Restrict Clock In when employee
reaches X hours.

This prevents an employee from
clocking in after X hours in a single
week.

Employee Message This is displayed to the employee the
next time he or she uses TimeClock
Plus to clock in or out.
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History This displays a list of each message
that has been sent to an individual
employee.  Message history must be
enabled in the Defaults for this option
to track history data.

Employee has read this message. This indicates whether or not the
employee has read the message since
it was last changed.

Scheduler

Approval required for… This prevents the employee from
clocking in or out outside of a specified
number of minutes of his or her
scheduled time.  See Restrictions in
the Reference Guide, p.75.

Round to scheduled… This rounds an employee’s time to the
scheduled time if the employee clocks
in or out within a specified number of
minutes of the scheduled time.   Both
the actual time and rounded time are
saved.

Notes

This is a generic space in which you may enter notes about this employee.

Photo

Allows for the storage of a photograph of the employee.  The image must be in
BMP format.  Internally photos are stored in the PHOTOS directory off of the
TimeClock Plus data directory.

Several screens allow you to copy the information to several employees.

To copy information to multiple employees:

 1) Select the employee and tab that you want to copy from.
 2) Click Copy.
 3) Enter the criteria for the employees you want to copy the information to.
 4) Click Ok.

—  OR —
 1) Select the employee and tab that you wish to copy from.
 2) Click Memorize.
 3) Select the employee that you wish to copy to.
 4) Click Recall.
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Exporting to payroll packages

TimeClock Plus has the ability to export to many popular payroll packages.
In order to do this, you must first purchase the appropriate Payroll Interface
module (bridge).  For availability and pricing, contact your DMI representative or
reseller.  If your payroll package is not supported, contact DMI for information on
obtaining a bridge.

To export to a payroll package:

 1) Launch TimeClock Manager.
 2) From the Reports menu, select Pay Period....
 3) Click Export.
 4) In the Destination Payroll Package drop-down, select the appropriate

package.
 5) In the Filename box, enter the filename to export to or select it from the

list of previous filenames in the drop down list.  Note that, by default, the
file is exported to the TimeClock Plus directory.  A different directory
may be specified here, e.g. C:\FOOPAY\HOURFILE if so desired.

 6) Check the appropriate options.  The precise options offered would vary
depending on the payroll package; refer to the documentation supplied
with the DMI payroll bridge for descriptions of each option.

 7) If you want to export only certain employees, click Criteria, and then
enter the appropriate values.  See Criteria in the Reference Guide, page
62.

 8) Click Process.
 9) Import the file into your payroll package.  Refer to the documentation

that came with your package for details.

Note that in some bridges, a program supplied by DMI performs step 9.  See
the instructions that came with your bridge for details.

Reindexing data files

TimeClock Plus, for the purposes of speed, keeps several indexes.  These
indexes are similar to the index of a book; they let TimeClock Plus quickly find
where information is located in a file.  From these indexes, TimeClock Plus
performs all of its database searches.

Unfortunately, these indexes can occasionally get a little out of kilter.  This is
a rare occurrence, owing mostly to power failures, improper termination of the
software, and the like.  However, when it happens, the consequences can range
from the frustrating to the bizarre.  The most frequently observed symptom of bad
indexes is that records that have just been added do not appear in the
appropriate lists.  Also, program errors such as general protection faults (GPFs)
and the like can occur.

TimeClock Plus has a facility to rebuild these indexes from scratch in case
they become corrupt.  This procedure is called Reindexing.  It is quick and
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painless, and never hurts your data.  In general, if you suspect an indexing
problem, it’s wisest to reindex.

Normally, TimeClock Plus will automatically reindex all your files each time
you close the week.  It also provides a menu option for you to reindex the files
yourself.  Note that if you want to reindex a week that has been closed, you must
open the week before reindexing.

To reindex your data files:

 1) Launch TimeClock Manager.
 2) From the Tools menu, select Re-Index Data Files.
 3) Mark the indexes you want to rebuild.  Under most circumstances, you

will want to rebuild all indexes, so click Select All to mark all check
boxes.

 4) Click Process.

After a brief bit of disk activity, the reindex will be complete.  Note that this
process does not reindex schedules; for that you must use TimeClock Scheduler.

Optimizing data files

For reasons dealing with speed and efficiency, when information is deleted
from the TimeClock Plus database files, it is not really deleted from the file;
instead, it is marked with a special code and ignored by all operations.  On
installations with much activity, this can sometimes make your database files
unnecessarily large, slowing down TimeClock Plus.  The process of actually
deleting the data is known as optimizing.  When TimeClock Plus optimizes a
database, it searches through and purges all the data that has been marked for
deletion.  It also eliminates errors from the database files.

TimeClock Plus automatically optimizes the current week’s clock in and
clock out records when you close the week.  It also gives you the option to
optimize the database files.  This is not a vital procedure under normal
conditions, although optimizing once every one to four months is recommended.
However, if you suspect a power failure or other incident may have corrupted a
database, you can optimize the databases to eliminate these errors.  You should
only optimize the databases when TimeClock Plus use is at a minimum (that is to
say, not at 5:00 PM on Friday afternoon).

To optimize the databases:

 1) Launch TimeClock Manager.
 2) From the Tools menu, select Optimize Data Files.
 3) Click Ok.

There should be a moment of disk access, and then your optimization will be
complete.
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10.  TimeClock Plus Features
There are many features in TimeClock Plus 3.0 that are not covered in the

User’s Guide.  This section of the manual is designed to provide you with the
details of these features.  Many of these features are optional and are not
required for basic timekeeping tasks.

Absences and Tardies

If schedules are entered and maintained, TimeClock Plus will keep track of
tardies and absences on a per-employee basis.  It can also allow particular
incidents to be marked as excused.

To view the tardies and absence records:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit.
 3) Enter the employee’s number.
 4) Click the Cumulative tab.
 5) If desired, click one of the Details buttons to view individual dates.  From

this screen, you can also mark excused absences.  In order for sick and
detail dates to be tracked, the associated default must be enabled in the
TimeClock defaults.  For more information see Defaults p. 63.

To reset these fields:

 1) Start TimeClock Manager.
 2) From the Tools menu, select Reset tracked fields.
 3) Mark the appropriate options in the left-hand column.
 4) If you only want to reset the hours for particular employees, click

Criteria and enter the appropriate values.  (See Criteria p. 62)
 5) Click Process.

Accruals

TimeClock Plus has the ability to track employees’ accrual of sick and
vacation time based on normal hours earned.  The parameters for this accrual
can be set on an employee-by-employee basis.

To configure accrual of sick and vacation time:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit.
 3) Enter the employee number you want to edit, then click Ok.
 4) Click on the Accrual tab.
 5) Enter the appropriate values in the fields.  The fields should be self-

explanatory; for help, press F1.
 6) Click Ok.
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Example: Dr. Wilson’s Computer Services provides two weeks each of sick
and vacation time per year, which equates to 80 hours/year, or 1.5385
hours/week.  To accomplish this, Dr. Wilson enters 1.5385 in the Sick and
Vacation columns for Hours earned each calendar week.  Because he doesn’t
want to pay for weeks when an employee works less than half of the week, he
sets Minimum hours required in week to accrue hours to 20 each.

Note that the number of hours accrued to date can be viewed on that tab, as
well as the number of hours remaining.  To see the number of hours used, click
on the Cumulative tab.

The accrued hours can be reset, or used hours can be subtracted from the
accrued hours (setting the used hours to 0 and the accrued hours to the number
of hours remaining).

To reset accruals:

 1) Start TimeClock Manager.
 2) From the Tools menu, select Reset tracked fields.
 3) Turn on the appropriate options in the right-hand column.
 4) If you only want to reset the values of particular employees, click

Criteria and enter the appropriate values.  See Criteria p. 62.
 5) Click Process.

Approaching Overtime Report

The approaching overtime feature allows you to monitor your employees’
hours to help control overtime.

To print the approaching overtime report:

 1) Start TimeClock Manager.
 2) Select Reports then Approaching overtime.
 3) Select the report criteria you want included.
 4) Click Print, or select Criteria to select a specific group of employees.

Attendance Monitor

This feature allows you to view a list of employees that worked, or were
scheduled during a specific time period on a specific day.

To initiate the Attendance Monitor:

 1) Start TimeClock Manager.
 2) Click on Tools then Attendance monitor.
 3) Enter a date and time range, not to exceed 48 hours or select a range

from Quick Pick.  Filter allows you to select the attendance criteria.  You
can also select Criteria to specify certain employees to include.

 4) Click Update to display the list.
 5) Click Print to print the list if desired.
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Example:  When you came in on Monday morning you noticed that the
break room was not clean.  It is the responsibility of the closing team to make
sure the break room is clean.  You launch the Attendance Monitor and key in the
date and time for yesterday evening and select the Worked During option from
the Filter menu.  After pressing the Update button, you are presented with a list
of all employees that worked the closing shift.

The Attendance Monitor has several different methods of determining
whether a person is working, has worked, or is scheduled to work.  From the
Filter drop down, several choices are available:

Clocked In During The employee is displayed if he enters onto the clock
during the time range specified.  If the employee is
already working they are not displayed.  This can be
useful in viewing clock in records for a certain period of
time.

Working During The employee is displayed if he is on the clock during the
specified period of time.  The employee will be displayed if
at any point in time they were clocked in.

Scheduled Clock In The employee is displayed if he is scheduled to clock in
within the given time range.   This can be useful to
determine who is scheduled to come in within the next
couple of hours.  A schedule is required.

Scheduled Working The employee is displayed if he is scheduled to be on the
clock at any time during the time range.  A schedule is
required.

Auto Updating

This feature takes you to our Internet site and retrieves any new
program updates of TimeClock Plus, automatically downloading and
installing them for you. You must have Internet access to use this
feature.

To Initiate Auto Updating:

 1) Establish a dialup Internet connection.
 2) Go to Programs, TimeClock Plus 3.0 and click on Auto Update.
 3) Click on Available and you will see a list of the latest program updates

available.  If there are no updates shown, you already have the latest
ones installed.  If there are updates on the list, simply select by clicking
on each one then click on Process.  This will download and install the
files.

 4) To exit this program click Exit.
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In some instances news about the TimeClock system will be
available.  If news is available you will be asked if you would like
to view it when retrieving updates.  To view the news answer yes,
otherwise answer no.

The other available options include:

Installed Displays the versions of all TimeClock Plus software installed
on your system.

Options Allows you to adjust system options.  Do this only at the
direction of tech support.

Register Online software registration.

Submit Allows you to submit a question or file to TimeClock support.
Please do not submit files without first speaking to a TimeClock
support representative.

Exit Exits the application

Backup and Restore

Backup your data files to a separate location on your hard drive or
to a removable media such as 3½” floppy or Zip disk.  Performing data
backups on a regular basis will keep you from losing your data in the
event of a file corruption of disk failure.

To backup data:

 1) Start TimeClock Manager.
 2) Select Tools then click on Backup system info...
 3) You can select the entire data directory or just select directories for

backup.
 4) Click on Start backup.
 5) Enter a file name for this backup.  Ex. “TCBack12-18-98”, this would

indicate a TimeClock Plus backup dated 12/18/98.  You do however
have the option to name this file anything you want.

 6) After making sure the path for the backup is correct, click on Save.
 7) When the backup is complete, a window will open displaying “Backup

completed successfully.”

To restore data:

 1) Start TimeClock Manager.
 2) Select Tools then click on Restore system info...
 3) Click on Select File.
 4) Making sure you are in the proper directory for your backups, select the

file you want to restore.
 5) Click Open.
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 6) Select All or only the files you want to restore.
 7) Click on Start restore.
 8) Click on Yes if you want to proceed or No if you do not.
 9) When the restore is complete, a window will open displaying “Restore

completed successfully.

Before attempting to restore a backup, it is recommended that you
create a backup of the existing TimeClock data.  This will ensure
that if the data you are restoring is not correct, you can always
revert to the current set of data.

Classification

The employees in TimeClock Plus can be divided into separate
classifications.  These classifications can be used to represent separate sites,
payment plans, service departments, or whatever other sort of division is useful.
(Note that departments are more frequently represented by job codes; see the
User’s Manual, p 14)  Classifications are numbers in the range 0–99999.

To set an employee’s classification:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the number of the employee whose classification you want to set.
 4) Enter the desired classification in the Classification box.
 5) Click Apply.

Several employees can be set to a particular classification simultaneously.

To set several employees’ classifications simultaneously:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Global modification.
 3) If you want to change all employees, go to the next step, otherwise,

click Criteria and enter the criteria for the employees you want to select.
This is particularly useful to change all employees in one classification
to another.

 4) Turn on the Change class check box.
 5) Enter the class you want to set the employees to in the Change class

to field.
 6) Click Process.

A box will appear indicating, for each employee, success or cause of failure.
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Cost Codes

Through the use of an additional module TimeClock Plus has the ability to
track information using cost codes.  Cost codes are another level of breakdown
that is most often used to track time on individual projects.  Cost codes are
entered and used on a company wide basis whereas job codes are entered on a
per employee basis.  When the cost code module is installed several new
features are enabled in TimeClock Manager and each of the TimeClock
applications that allow for managing and reporting of each of the codes.

 For help on entering cost codes see Adding Cost Codes in the Users
manual, p. 22.

Criteria

For several operations in TimeClock Plus, it is possible to enter particular
criteria for the operation, so that only particular employees are affected.  The
details of how criteria are specified are explained here.

The criteria can hinge on the employee number, class, job codes, or last
name.  Only employees meeting all of the selected criteria are included in the
operation; employees meeting some of the criteria but failing others are
excluded.

In addition to the standard fields, the criteria can also be based on the
miscellaneous fields.  These fields are set up in the TimeClock defaults screen
and are entered on a per employee basis from the Info screen of the employee
record.  For the three check fields, each can be on, off, or unused.  If the field is
on or off, the employee must have the same setting to be included.  If the field is
grayed, it is ignored when processing criteria.

The tracked edit field, also set up in defaults, has several options for
inclusion.  By pressing the “+” button the inclusion option can be cycled from
“equals” to “contains” to “value is”.  If set to “equals” the edit field must exactly
match (not case sensitive) the edit field in the employee record.  If set to
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“contains”, the employee matches the criteria if their edit field contains the
entered text at some position.  For example, if “BC” is entered and the
employee’s edit field contains “ABCD”, it is considered a match whereas “BAC” is
not.  If set to “value is”, a numerical comparison is performed between the two
edit fields.  Note that text values in the edit field of an employee record have a
value of zero.

 For the numeric fields, several ranges can be entered, separated by
commas.  Also, single numbers instead of ranges can be entered.

Example: Dr. Fred Wilson’s Computer Services spans three sites now.  Dr.
Wilson assigns the employees at Site A numbers from 1–9999, employees at
Site B the numbers 10000–19999, and employees at Site C 20000–29999.  Also,
he assigns employees who are salaried classification 10, employees who are on
hourly wages classification 20, and employees hired through a local temporary
employment service classification 30.  If he wants to work with employees from
Site A, he can select employee numbers 1–9999 and classifications 0–99999.  If
he wants to work with employees who are from the employment service, he can
select employee numbers 0–9999999999 and classification 30.  If he wants to
work with employees from Sites A and C who are paid hourly, he can select
employee numbers 1–9999,20000–29999 and classification 20.

Defaults

TimeClock Plus has several configurable options, known as defaults.  These
defaults affect the way that TimeClock Plus works in various ways.

To set defaults in TimeClock Manager, from the Configuration menu, select
Preferences, then Defaults.  For more information on individual defaults, select
the page and press F1 for help.

Manager

Items to Track Determines whether detailed tracking is enabled for
certain items.

Breaks Highlighted in
Edit Hours

If enabled, shifts with breaks are displayed in a
different color when editing hours.

Shift lengths in minutes
when editing hours

Will display shifts in the HH:MM format instead of the
HH.HH format in the edit hours screen.

Current labor cost on
status bar

Will display the current cost of labor on the bottom of
the TimeClock Manager main screen.

Reminder messages
when time to close the
week.

When it is time to close the week, a message will
popup when Manager is first run to notify the user
this operation must be done.

Save entered sales in If enabled, sales figures entered in the labor cost
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labor cost. screen will be saved with the current week when it is
closed.

RETURN functions as
TAB in edit fields

If enabled, the return key will move the cursor to the
next edit field.

Remove suspended
employees from drop
down lists.

If enabled, suspended employees will not show
when selecting an employee from the employee list.

Enable job costing If the job-costing module is installed, job costing can
be enabled and disabled via this button.

Auto copy schedules
from week to week.

Some people use the same schedule from week to
week.  This option instructs TimeClock to move the
current schedule to the next week when the week is
closed.  This will only take place if there is not
already a schedule for the next week.

TimeClock

View Hours

View Current Schedule

View Next Schedule

View Last Punch

Determines what access an employee has to his
hours when clocking in and out from the on screen
TimeClock or RDT.

Edit Hours on RDT Determines whether hour editing is enabled on the
RDT.  For more help on this feature see Editing
Hours on the RDT, p. 33.

Print hours when viewing If enabled, users of the on screen TimeClock have
the ability to print their hours when clocking in/out.

Display employee
number on clock in/out

Determines if the employee number is visible when
clocking in/out.  If disabled asterisks will display.

Job Code Change Option If disabled, the button for changing job codes will not
be displayed to the user.

Break Option If disabled, the button for going on break will not be
displayed to the user.

Miscellaneous

Tracked Field and
Decimal places

Determines the name and number of decimal places
for the tracked field.  Some examples are miles, tips,
parts, pieces, etc.
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Maximum break length Determines the maximum number of minutes for a
break.  Breaks over this amount of time are
considered a clock out.

Management Message A message that will be displayed to all employees
when clocking in or out.  Individual messages can be
sent by entering the message into the employee
record.

Current Week Displays the current TimeClock seven-day week.

Base Pay Period Date A date used for calculating pay period ranges in
reports.  Enter a date that corresponds to the first
day of one of your pay periods.

Pay Frequency Used to calculate default dates when printing
reports.  Does not have anything to do with the
method of calculation of data.

Period starts on… Used when semi-monthly or monthly periods are
selected to determine what dates the periods start
on, i.e. the 1st and 16th.

Start of day This field is used solely for display purposes in labor
cost.

Fields

Each of these entries represents the description of the miscellaneous fields that
are tracked on a per employee basis.  These fields can be found on the Info
screen of each employee.  They can also be found in the Criteria when filtering
employees for reporting or other purposes.

Employee Entry

Items checked in this area will be required in the employee information screen.
For example, if you require that all new employees have a social security number
entered, place a check in the SSN field.

Exporting

TimeClock Plus provides several areas to export data from the system.  The
most common of these is exporting payroll data.   For more information on
exporting to a payroll package see Exporting to a Payroll Package on p. 53.

In addition to exporting calculated payroll data, TimeClock Plus offers the
ability to export raw information to a text file.  The exporting of this data is in a
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customizable format that allows you to export so that virtually any program that
has import capabilities can import it.

To export hours for the current week:

 1) Launch TimeClock Manager.
 2) From the Employee menu choose Export Raw Hours…
 3) If you have a saved format, select it from the Current Format drop

down list, otherwise enter a new format using the data provided in the
Fields box.

 4) Click Process.
 5) Enter a filename for the export file.
 6) Enter the date range you would like to export from the current week and

click Ok.  Note that in order to export history data you must first view a
previous week from the File menu.

 7) The file is now created and ready for import or use in another
application.

To export employee information from the employee list:

 1) Launch TimeClock Manager
 2) From the Employee menu choose Export Information…
 3) If you have a saved format, select it from the Current Format drop

down list, otherwise enter a new format using the data provided in the
Fields box.

 4) Click Process.
 5) Enter the filename for the export file.
 6) Click Save.
 7) The file is now created and ready for import or use in another

application.

Hints on Exporting Raw Data

When exporting raw data, fields can be formatted in several different ways.
By default all fields are exported using their default width with trailing spaces.  To
export data and trim the trailing spaces you must use a dash in between the
percent and the letter representing the field.  For example, the address field is
represented with “%f”.  Using “%f” by itself will yield a 40 character field with the
address followed by space padding up to 40 characters.  If “%-f” is used, the
address is exported without the trailing spaces so it is no longer a fixed length
field.

To export data into a specific column size, you should insert a number
between the percent and the letter representing the field to be exported.  For
example, if you would like the address field exported in a 65 character column,
you should enter “%65f” in the Export Format area.  Likewise if you would like to
trim the field to 10 characters, you could use “%10f”.  This action will trim all
addresses to 10 characters on the export.



TimeClock Plus Reference Guide 67

Example:  A payroll system requires employee data in the format “first
name,last name,address,city,state,zip”.  To create this file, enter
“%c,%d,%e,%f,%g,%h,%I%N” into the Export Format area and click process.
Note the %N at the end of the export format that represents an end of line.  Most
exports will contain at least one %N to force data onto separate lines.

Global Editing

Global Editing provides a way to edit several employees at the same time.
TimeClock Plus has the Global Record Addition facility to add shifts to all
employees, as well as the Global Employee Modification facility to add, delete, or
modify job codes globally.

 Example: Dr. Fred Wilson has decided to give his employees April Fool’s
Day off.  He has never tracked holiday pay before, so he first adds job code
1002, Holiday Pay, to the master job code list through the normal means (see the
User’s Manual, p).  Since adding a job code to the master job code list doesn’t
make it so that employees can use that job code, he then uses the Global
Employee Modification facility to add job code 1002 to all his employees.  Then,
Dr. Wilson uses the Global Record Addition facility to add a shift from 9:00 AM
through 5:00 PM under job code 1002 (Holiday Pay) for all his employees.

The Global Employee Modification facility allows you to add or remove a
particular job code to all employees or just those meeting particular criteria.  It
also lets you modify the pay rate and other flags affecting the job code.  Also, it
allows you to change all employees, or just those meeting particular criteria, to a
different class (see p. 62).

To use the Global Employee Modification facility:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Global Modification....
 3) If you want to affect only certain employees, click Criteria and enter the

criteria for the employees you want to modify.
 4) If you want to set the employees’ class, turn on the Change class

button, and enter the new class in the Change class to field.
 5) If you want to modify the job codes for these employees, continue to

step 6.  Otherwise, proceed to step 9.
 6) Turn the job code button to Add, Remove, or Modify.
 7) Select the job code you want to affect.
 8) If you are adding or modifying the job code, set the check boxes to their

appropriate values and enter the appropriate rate of pay.
 9) Click Process.

After processing the employees, a screen will appear indicating the success
or cause of failure for each employee selected by the criteria.

The Global Record Addition facility allows you to add shifts for all
employees, or those meeting specified criteria, simultaneously.  Note that this will
not add shifts for employees who do not work under those job codes; that is, if



68 TimeClock Plus Reference Guide

you add shifts for job code 105, then those employees who are not assigned job
code 105 will be unaffected.

To use the Global Record Addition facility:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Global Record Addition.
 3) Enter the date in, time in, date out, and time out.
 4) Select the job code from the list in the Job Code box.
 5) If you want to use a particular rate for all employees, enter that in the

Rate box.  Otherwise, turn on the Use employees’ default pay rate
option.

 6) Enter the tips or other tracked field in the Tips box.
 7) If you use cost codes, select the appropriate value in the Cost Code

box.
 8) If you want to include employees who have been suspended from

clocking in or out (see p. 49), turn on the Include suspended
employees box.

 9) If you want to process all employees, proceed to the next step.
Otherwise, click Criteria and enter the appropriate criteria for the
employees you want to include.

 10) Click Process.

A box should appear indicating the success or reason for failure for each
employee included in the selected criteria.

Holiday Calendar

TimeClock Plus can keep a holiday calendar to report holiday hours worked
on some reports.  Hours worked on holidays appear on the Complete Payroll
report with an ‘h’ next to them.  Besides this special notation, holiday hours are
not treated special in any way.  TimeClock Plus does not count hours worked on
holidays as overtime, nor does it add their hours to these days automatically.  All
this feature does is to add the special notation on the Complete Payroll report.

To mark holidays:

 1) Start TimeClock Manager.
 2) From the Configuration menu, select Holiday Calendar.
 3) Use the Next and Previous buttons to select the month you want to

edit.
 4) Click on the day you want to configure as a holiday.
 5) Click Edit.
 6) Enter the name of this holiday.
 7) Select the appropriate button for Report as Holiday Hours or Do Not

Report as Holiday Hours.
 8) Click Ok.
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Due to the many different ways that holiday hours can be collected and paid,
these hours are only reported as holiday and not exported as holiday.  Hours
worked on holidays will be reported as normal hours and will follow the rules of
calculation for which the employee has been set up.

Importing Information into TimeClock Plus

TimeClock Plus has the ability to import data into most areas of the
system.  The import mechanism is very flexible and allows importing in
virtually any format including delimited text, fixed length text, and
DBASE compatible files.  If you are importing files from software such as
Microsoft Access or Excel, use the features in these applications to save the data
to a format that TimeClock Plus can import such as comma delimited ASCII.

To import a file into the TimeClock system:

 1) Select the appropriate import corresponding to the file you will be
importing.  Imports for employee data such as name, address, hours,
job codes, etc. are located on the File menu of the TimeClock Manager.
Company job code and cost code imports are located under the edit
master job code and cost code lists in the configuration menu of
TimeClock Manager.

 2) Enter the name of the file in the Filename to Import section.  If you do
not know the name or location of the file, you can press the browse
button (… ) to locate the file on the local hard disk or a network drive.
Once the filename is entered, the system will automatically attempt to
determine the format of the file and place this in the file type section.  If
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the format is not correct, selecting the type from the drop down list can
manually change it.

 3) Enter the number of records to skip in the import file in the Records to
Skip edit box.  Some files contain header information when exported
from a payroll system or accounting package.  The “records to skip”
section tells the import to ignore the number of specified records at the
start of the file.  A record is defined as a line in the import file.  Once a
valid file name is entered, the first ten records of the file will be
previewed in the File Preview section.  If you can see header records in
this preview window that should not be imported, adjust the records to
skip until no header records are visible in the preview window.

 4) If you are importing a delimited ASCII text file, select the delimiter that
separates each item on a record in the import file.  Most files are
comma delimited, but files can also be delimited with spaces, tabs,
pipes, or any other valid character.  Before selecting Next, be sure to
select the proper delimiter for the file being imported.  From the drop
down list the delimiters comma, tab, pipe, space, and other can be
selected.  If your file uses a delimiter other than the standard, you can
select other and key the delimiter into the edit box for delimiter.  If the
delimiter is a non-printable ASCII character, you can key it into the
delimiter field by entering a backslash ( \ ) followed by the three digit
ASCII code for the delimiter.  For example, if the file were delimited with
the ASCII value 128, you would enter “\128” in the delimiter field.

 5) Enter the name of the default map file for this import.  A map file is the
list of associations between the import and TimeClock Plus fields.  If this
is the first time you have imported a file of this type, leave this field
blank.

 6) Once all information is entered for the import, select the Next button to
proceed.  If any information is incorrect, you will be given an error and
you can make any necessary corrections before continuing.

 7) If you are not importing a fixed length ASCII file, skip to the next step,
otherwise,  you will be presented with a screen similar to the following:

This screen is used to map the column assignments of the data in the
fixed length file.  In order for the system to know what columns
represent valid data you should place a mark at the beginning of each
column of data.  A column of data is considered to be from a marker to
the character to the left of the next marker.  In the example above,
“David        “ will be considered to be the first column of data.
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Also note that some files contain data that is not pertinent to TimeClock
Plus.  In order for the import process to parse the data properly, these
columns should also be marked.  In the example screen above, if “052”
represented the employee’s age, it should be marked as a column of
data.  TimeClock Plus does not have a field to import age, but if it were
not selected as a column, the address field would import as “123
AnyStreet     052” because the system would assume that the address
column ends in the character preceding the “T” in “Tx”.

NOTE that if you are attempting to import a fixed length ASCII file the
columns of each record should always be in the same fixed position.
The system will only allow one fixed map per file.  Although the fields
should always be in the same position, the records in the file do not
necessarily have to be the same length. If the record sizes vary, only
data up to the end of any given line will be imported.

 8) Map each of the fields in the import file to the appropriate TimeClock
Plus field.  To map a particular field in the import file, click on the
TimeClock Field Mappings side of the row for the item you would like to
map.  A drop down list of all available items to map will appear.  Select
the name of the item that corresponds to the field in the import file.
Note that items in the drop down list with an asterisk after their name
are required fields and must be present before an import can be
processed.  For example, when importing job codes the import cannot
proceed if a job code number is not mapped to an item in the import file.

If you would like to clear the mappings and start over, press the Clear
Map button.  If the file format is something that you will be importing on
a regular basis you may want to click Save Map to save the map to a
file for later use.  This will eliminate the need to re-map the file every
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time it is imported into the system.  If you have previously created a
map for this file format and did not specify the default map file in the
previous screen, you can load the map from this screen by using the
load map button.

 9) Once all mappings are complete press the Next button.  If there are any
required fields that are not mapped you will be given an error message
and be required to map those fields before continuing the import
process.

The final screen of the import process is the summary screen.  This
screen summarizes the import process that is about to take place.  As
stated in this dialog, it is recommended that a backup be done before
importing any data into the TimeClock system.  The backup can be
performed from the TimeClock Manager by selecting Backup System
Info from the Tools menu.

 10) Click the Finish button to process the import.  As the file imports, an
import status dialog will be displayed.  Once the import is complete a
dialog will be displayed showing the number of records read, number of
records imported, and the number of errors found.  If errors were
present in the import, you can select the View Errors button to view and
print the errors.
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Labor Cost Analysis

The Labor Cost Analysis provides an hour-by-hour breakdown of number of
hours worked and wages paid, and labor percentage of sales for all employees.
A summary at the bottom of the window provides total hours, wages, sales, and
labor percentage.  The summary can be set to display totals for either the day or
the week.

To access the Labor Cost Analysis in TimeClock Manager, select the Tools
menu, and then select Display labor cost.  To set the sales (used in calculating
the labor percentage), click on the Sales button.

The Options button provides the ability to set several different options,
including job codes included in analysis, whether hourly or daily figures are used
for sales, and whether or not salaried employees are to be included in the
analysis.

The information can be displayed in a graphical format by clicking Visual.
The Wages column can be replaced with an hour-by-hour labor percentage
column by clicking Toggle.  Note that the labor percentage column is not useful
unless hourly sales figures have been entered by turning on the option in the
Options screen, then entering the appropriate figures in the Sales screen.

Overtime

TimeClock Plus can calculate overtime in many different ways including
daily, weekly, bi-weekly, and combinations of each.

To set the overtime calculation for an employee:

 1) Launch TimeClock Manager
 2) From the Employee menu choose Edit…
 3) Enter the employee number to edit and click Ok.
 4) Select the Overtime tab.
 5) Enter the values for the type of overtime desired and click Ok to save

the information for the employee.

Passwords

TimeClock Plus supports password-protecting your data against prying eyes
and fingers.  There are four different passwords available, two to allow
administration and two to override restrictions on clock in and clock out times.

The Supervisor password is the password that is used when logging into the
system as Supervisor.  The Supervisor user has full access to all TimeClock
functions and options.  In a situation where only one user is administrating the
TimeClock system and user level access is not required, the administrator can
log in as Supervisor to control the TimeClock system.
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The User password option is used to change the password of the current
user that is logged in.  This option is only visible when a user other than
supervisor is logged into the system and the user has access to Change own
user password as setup in the user profiles section (see p. 79).

The Remote Terminal Password is used as an override to allow employees
to clock in or out at a remote data terminal (RDT) regardless of schedule or
overtime restrictions.  It is a numeric password up to eight digits.  The TimeClock
Restriction Password is the corresponding password for employees clocking in or
out at a computer using the TimeClock Plus program.  It is an eight-character
password consisting of letters, numbers, and symbols.  If either password has
not been configured, employees clocking in or out at the corresponding location
will not be restricted.

The Edit Hours in RDT password is the password that is used when logging
into the edit hours function on the RDT as supervisor.  This is a numeric
password and is only used when editing hours as supervisor.  For more
information on editing hours on the RDT, refer to p. 33.

In all cases, passwords are never displayed on the screen.  Instead, each
character is displayed as an asterisk (*).

To configure a password:

 1) Start TimeClock Manager.
 2) From the Configuration menu, select Preferences, then Passwords.
 3) Select the password you wish to set.
 4) Click Edit.
 5) If this password has previously been set, enter it in the Old Password

field.
 6) Enter the desired password in the New Password and the Re-enter

New Password fields.  To remove a password, leave these fields blank.
(Two fields are used to avoid typographical errors.)

 7) Click Ok.
 8) Click Exit.

Quick Add Hours

This feature can be used to add hours to one or more employees.
It is much faster than using Employee Edit Hours if you have several
employees to add.

To Quick add hours:

 1) Start TimeClock Manager.
 2) Click on Employee then Quick add hours.
 3) Enter the employee number or select from the drop down list.
 4) Enter the dates and hours you want to add, you can then select a job

code, rate and cost code.
 5) Click on Add.
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 6) Repeat steps 2 - 5 for each employee you want to add hours too.

Required Fields

You can set certain fields to require entry when adding employees.
You will not be able to setup and save employee information unless
you enter information in all of the required fields.

To setup required fields:

 1) Start TimeClock Manager.
 2) Click on Configuration, Preferences, Defaults then Employee entry.
 3) Place a check beside each field you want to require.
 4) Click on Ok to finish.

Reset Tracked Fields

TimeClock Plus tracks several different items on a per employee basis. It is
sometimes necessary to reset these fields.

To reset these fields:

 1) Launch TimeClock Manager.
 2) From the Tools menu, select Reset tracked fields.
 3) Check the box by the Tracked Fields you want to reset. You may also

select to reset select fields prior to a specified date.  This enables you to
keep the most recent data in these fields.

 4) If you want to reset the tracked fields of particular employees, click
Criteria and enter the appropriate values.  For more information see
Criteria on page 62 in the Reference Guide.

 5) To start the reset, click Process.

Restrictions

Employees can be restricted from clocking in or out under various
conditions.  Employees can be restricted from clocking in or out too far outside of
their scheduled time, and restricted from clocking in after they start accumulating
overtime, reach a specified number of hours, after a particular date, or
completely restricted from clocking in.

Before any restrictions can take place, the appropriate passwords must be
set up.  Failure to set up the proper passwords will cause the restrictions to be
ignored by TimeClock Plus.

For help on changing the TimeClock restriction passwords for the on-screen
TimeClock and the RDT, see Passwords, p. 73.
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To restrict employees from clocking in or out too far outside of their
scheduled time:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the employee number you want to restrict and click Ok.
 4) Click on the Scheduler tab.
 5) Turn on the options you wish to restrict in the Approval Required For

box.  Enter the number of minutes of leeway you want to provide in the
corresponding text field.

Example: Dr. Wilson wants to prevent Fred Bloggs from showing up
more than 10 minutes late or leaving more than 30 minutes early
without special approval.  He edits Fred’s employee record and marks in
the Approval Required For box the options Late clock in Outside 10
minutes and Early clock out Outside 30 minutes.

 6) Click Ok.

Employees can be restricted from clocking in after they start earning
overtime.  Note that this only restricts employees who are clocking in, not
clocking out.  If an employee starts earning overtime during a shift, this restriction
does not take effect until the next time that employee clocks in.

To restrict an employee from clocking in while earning overtime:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the employee number of the employee you want to restrict.
 4) Click on the Restrictions tab.
 5) Turn on Restrict Clock In when employee reaches overtime.
 6) Click Ok.

Employees can also be restricted from clocking in after they earn a specified
number of hours.  Like the previous restriction, this only affects employees when
they are clocking in.

To restrict an employee from clocking in after a specific number of hours:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the employee number of the employee you want to restrict.
 4) Click on the Restrictions tab.
 5) Turn on Restrict Clock In when employee reaches  X   hours.
 6) Enter the appropriate number of hours in the text field.
 7) Click Ok.

Employees who leave the company with advance notice can be restricted
from clocking in after a specified date.  Like the previous two restrictions, this
only affects clocking in.
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To restrict an employee from clocking in after a specific date:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the employee number of the employee you want to restrict.
 4) Click on the Info tab.
 5) Enter the appropriate date in the Left field.
 6) Click Ok.

Employees who have been suspended can be restricted from clocking in
entirely.  This also removes the employees from the drop-down lists except the
Edit Employee drop-down (if the option Remove suspended employees from
drop-down lists in the Defaults screen is on) and from many calculations.  They
will still print on reports for any week that they have hours in, however, and their
records can be edited in the normal manner.

To suspend an employee:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the employee number of the employee you want to restrict.
 4) Click on the Info tab.
 5) Turn on Suspended.
 6) Click Ok.

Reviews

This feature allows you to maintain documentation relating to
employee reviews within TimeClock Plus.

To enter Employee reviews:

 1) Start TimeClock Manager.
 2) Select Employee and Edit.
 3) Enter the employee number of the employee you want to edit or select

from the drop down list
 4) Click on the Reviews tab.
 5) Click on Add.
 6) Enter the review date, review time, description of the review and any

notes you want to retain.
 7) When finished, click Ok.

Tips

TimeClock Plus can track an additional numeric field.  This can be tips
earned, mileage, pieces of mail handled, calls answered, or whatever your
company needs to track.  Throughout this manual, the tracked field is referred to
as tips, regardless of what your company may track.
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Although the manual refers to the tracked field as tips, your company can
change the name of this field to whatever you want, up to 6 characters.  You can
also set the number of decimal places maintained, from zero to four decimal
places.  However, only maximum of five digits can be stored.  If you have zero
decimal places, tips can range from 0–99999; if you track four decimal places,
tips can only range from 0–9.9999.

Note that changing the number of decimal places tracked has a retroactive
effect: all prior records will change to the number of decimal places, without
regard to digit placement.  If you change from two decimal places to zero, tips
previously entered as 1.05 will become 105.

To change the name of the tips field:

 1) Start TimeClock Manager.
 2) From the Configuration menu, select Preferences, then Defaults.
 3) Click on the Miscellaneous tab.
 4) Enter the name to give the tracked field in the Tracked Field field.
 5) Enter the number of decimal places to track in the Decimal Places field.

The tips field need not be used for every job code.  It can be enabled on a
per-employee, per-job code basis.

To enable or disable tips tracking for a particular employee and job code:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit....
 3) Enter the number of the employee for whom you want to enable tips

tracking.
 4) Click on the Jobs tab.
 5) Find the job code you want to enable tips tracking for.  The Tips column

indicates whether or not tips tracking is already enabled.
 6) To toggle tips tracking on or off, click on the job code, then click the

Tips button.

You can specify a default for tips tracking for each job code, which is used
when a job code is added to an employee.  Setting this default does not affect
employees already using that job code.

To enable or disable tips tracking by default for a particular job code:

 1) Start TimeClock Manager.
 2) From the Configuration menu, select Master Job Code List.
 3) Click on the job code you want to modify, then click Edit.
 4) In the Job Defaults box, set Tip Entry to the value you want.
 5) Click Ok.

When an employee clocks out from a shift that requires tip entry, they will be
asked to enter the tips for that shift.  They will also be asked for tips when
clocking out on break or changing job or cost codes.
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TimeClock Plus also provides a Tracked Field Report, which gives the tips
earned, broken down by employee, then by job code with totals, then by week
with totals.  For information on printing the Tracked Field Report, see the User’s
Guide p. 35.

Tracked Codes

TimeClock Plus automatically tracks cumulative total time, sick time, and
vacation time.  In addition, three other job codes can be tracked.  Do not confuse
these tracked codes with the tracked field, or tips field.

The job codes to be tracked can be set by selecting, from the Configuration
menu, the items Preferences, then Tracking.  Select the three job codes you
want to track in the three fields.  From now on, the cumulative totals for each of
those three job codes, in addition to sick and vacation pay, will be tracked.  Note
that each time these are changed, the totals normally should be reset to zero.

To view or edit the totals for an employee, simply edit that employee’s record
and click the Cumulative tab.

To reset the totals:

 1) Start TimeClock Manager.
 2) From the Tools menu, select Reset Tracked Fields.
 3) Mark the tracked codes you wish to reset.
 4) If you wish to reset sick and/or vacation cumulative totals, mark

Vacation hours taken and/or Sick hours taken.
 5) If you wish to reset sick and vacation details, click Clear sick/vacation

date tracking and enter the first date you want to save.

Example: Dr. Wilson no longer has need of sick and vacation pay details
prior to 1998.  He marks Clear sick date tracking prior to 1/1/1998 and Clear
vacation date tracking prior to 1/1/1998.

 6) If you only want to reset the marked fields for certain employees, click
Criteria and enter the appropriate criteria.

 7) Click Process.

User Profiles

TimeClock Plus includes special features to allow different users to have
different access privileges.  Individual users can be configured, each with a
different password, to allow each user to access only specific functions.  In
addition, each user can be configured to only have access to specific employees.
Note that the user list is entirely separate from the employee list; as far as
TimeClock Plus is concerned, the users configured have no relation to
employees.  If you want a user to be able to clock in and out, the user must be
added to the employee list, just like any employee.  Note that the Supervisor is a
special user and cannot be edited.
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To configure a user:

 1) Start TimeClock Manager.
 2) From the Configuration menu, select User List.
 3) If you are adding a new user, continue to the next step.  Otherwise,

select the user in the User ID box and skip to step 9.
 4) Click Add.
 5) Enter a brief identifier in the User ID field.
 6) Enter the user’s name in the User Name field.
 7) Click Ok.
 8) Review the list of possible activities, and mark the ones that this user is

to be allowed to access.
 9) To provide this user with access only to certain employees, click on Edit

and enter the criteria for the employees this user may access.  (See
Criteria, p. 62).

 10) If you want to change this user’s password, click Edit, then select either
the Access or RDT password button, and enter the appropriate
information.  See Passwords, p. 73.

 11) Click Done.

After user logins have been enabled, a Login screen will appear anytime
TimeClock Manager or TimeClock Scheduler is launched.  In the first box, enter
either a user ID or SUPERVISOR.  In the second box, enter the appropriate
password.

Note that the supervisor login is always enabled.  If you activate
user IDs, be sure to set a supervisor password.  For help on
setting this password, see Passwords, p. 73.

Verifying hours

Employees and management now have the ability to verify hours
worked.  This is especially helpful if you have a number of different
departments with supervisors responsible for verifying their employees’
hours.

Employees can verify hours from the TimeClock window by:

 1) When clocking in or out, employees can click on View hours displaying
a window showing shifts worked.

 2) Highlight the shift you want to verify and while holding the cursor next to
that shift and under the Ok column, click the mouse button, this will
place a check beside the shift.

To verify employees hours from the TimeClock Manager window:

 1) Start TimeClock Manager.
 2) From the Employee menu, select Edit hours.
 3) Enter the employee number or select from the drop down list.
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 4) Highlight the shift you want to verify and while holding the cursor next to
that shift and under the “M” column, click the mouse button, this will
place a check beside the shift.

A red checkmark under the “M” column indicates the manager has verified
the hours in that shift.  A blue checkmark under the “E” column indicates the
employee has verified the hours in that shift.

Who’s here and call list

TimeClock Plus provides the ability to instantly see what employees are
clocked in, who has overtime, and who should be called if more workers are
needed to avoid costly overtime.  These abilities are provided through the Who’s
Here and the Call List functions.

The Who’s Here list can be accessed from the Tools menu.  From this list,
you can see which employees are currently clocked in.  If the Include “on
break” box is checked, then employees who are on break will also be included.
By clicking the Absent button, a list of employees who are scheduled to work but
not present will be displayed.  By clicking on an employee in the list, that
employee’s shift can be inspected with the Shift Info button, or the employee
can be clocked out with the Clock Out button.  The list is automatically updated
every 60 seconds.  Additionally, the list can be updated with the up-to-the-second
information at any time by clicking Update.

Example: Dr. Fred Wilson, owner and proprietor of Wilson Computer
Services, keeps regular tabs on his employees with Who’s Here.  As he
approaches the computer, he sees that the Who’s Here window is already
displayed.  Because a shift change has recently taken place, he clicks Update to
ensure that he has current information.  Looking over the list, he notices that
Jimmy Bloggs is clocked in.  Since Dr. Wilson saw Jimmy leave, he assumes that
the young boy forgot to clock out.  Dr. Wilson clicks on Jimmy’s name, then on
Clock Out.  He enters the date and time that Jimmy left, and then clicks Ok.

Dr. Wilson also notices that Mary Bloggs isn’t clocked in.  He clicks on
Absent to view the absent list.  When he sees that Mary isn’t listed on the absent
list either, Dr. Wilson remembers that Mary wasn’t scheduled to work today.

The Call List can be accessed from the Tools menu or from the Who’s Here
list.  It displays a list of all employees, sorted by number of hours accumulated
this week.  Employees who have overtime are displayed in red, while employees
who are currently clocked in are displayed with an asterisk (*).  The call list is
designed to allow employers and managers to call in employees for special jobs
when necessary, and still keep overtime hours to a minimum.
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11.  TimeClock Scheduler
Some features of TimeClock Plus require the program to be aware of the

employees’ schedules.  In particular, the abilities to track tardies and absences,
to restrict employees to a fixed schedule, and to print scheduled vs. actual time
reports depend on a current schedule existing.  This schedule is entered and
maintained using the TimeClock Scheduler.

Build Necessary Shifts

TimeClock Plus will automatically build a necessary shift list based
on an entered schedule.  This can be useful when initially converting
from a written schedule to the TimeClock system.

To build necessary shifts from a schedule:

 1) Start TimeClock Scheduler.
 2) Create or open a schedule.
 3) From the Tools menu select Build Necessary Shifts…
 4) If you are ready to proceed with a build of the necessary shifts, press

Proceed, otherwise press cancel.
 5) Click Close.

Creating Schedules

Like the rest of TimeClock Plus, the Scheduler organizes its data in weeks.
At any time a schedule is being edited, the week of that schedule is displayed at
the bottom of the TimeClock Scheduler window.  Under normal conditions, the
only time a week is not open is the first time that TimeClock Scheduler is run.

To create a new week:

 1) Start TimeClock Scheduler.
 2) From the File menu, select New Schedule....
 3) Click on the Next and Previous buttons to select the week you wish to

create a schedule for.
 4) Click Ok.
 5) Confirm the date displayed, then click Yes.
 6) If you wish to base this week on a previous week, click Yes and

proceed to the next step.  Otherwise, click No; a blank week will be
created.

 7) Select the week you wish to base the new week on.
 8) If you want to copy the employees’ schedules from the previous week

(as opposed, say, to just necessary shifts) then turn on the Copy
Employee Schedules option.

 9) If you want to copy the necessary shifts from the previous, turn on the
Copy necessary shifts option.
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 10) If you only want to copy certain employees, then click Criteria and
select the employees you want copied.  (See Criteria, p. 62)

 11) Click Process.

To edit a previous week, simply select from the File menu, the option Open
Schedule....  To delete a week, select from the Tools menu, the option Delete
past schedule....  Note that the week currently being edited cannot be deleted.

Daily Overall Schedule

The daily overall schedule is a visual representation of the current schedule.
In the top half of the window is a graphical list of all employees that are
scheduled for the particular day.  On the lower left of the window is a list of
employees that can be scheduled.  On the lower right of the window is a list of
necessary shifts that still need to be filled for the week.

To view the daily overall schedule:

 1) Launch TimeClock Scheduler
 2) From the View menu choose Daily Overall Schedule…

To schedule a shift using the daily overall schedule:

 1) Select an employee from the list of employees at the bottom left corner
of the window.

 2) Double-click on a shift in the necessary shifts list in the right corner of
the window or click on a shift and click Assign.

To get more information about a scheduled shift:

 1) Select the day to view using the tabs
 2) Position the mouse cursor over the shift in the graphical window
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 3) Press and hold the right mouse button.

To open the individual schedule window to edit a shift:

 1) Select the day to view using the tabs.
 2) Locate a shift for an employee you would like to edit.
 3) Double click the bar representing the shift.

Editing Individual Schedules

The schedule can be viewed in one of three ways: the weekly overall
schedule, the daily overall schedule or individual employees’ schedule.

To view the overall schedule, select from the View menu, either Weekly
overall schedule or Daily overall schedule. Individual employee schedules can be
viewed by double clicking on the appropriate line in the Overall Schedule, or by
selecting the Employee Schedule from the scheduler menu.

To add shifts to an employee’s schedule:

 1) Start TimeClock Scheduler.
 2) Create or open a schedule.
 3) Display the employee’s schedule.
 4) Double-click on a free slot on the day you want to add the shift.
 5) Enter the appropriate information for Date In, Time In, Date Out, and

Time Out.
 6) Select the appropriate job code for the shift.
 7) Optionally, enter a brief description of the shift.  This description is only

used for display during editing and on printed Scheduler reports; it does
not affect operation in any way.

 8) Click Ok.

To delete shifts from an employee’s schedule:

 1) Display the employee’s schedule.
 2) Click on the shift you wish to delete.  The shift will be highlighted in

purple.
 3) Tap the Delete key.

To copy shifts from one day to another:

 1) Display the employee’s schedule.
 2) Click on the shift you wish to copy, but do not release the mouse button.
 3) Holding down the button, drag the shift to the day you wish to copy it to.
 4) Release the mouse button.

To copy days from one day to another, or one employee to another:

 1) Display the employee’s schedule.
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 2) Click on the day you wish to copy.
 3) Click on the Copy button.
 4) Select Copy day.
 5) If necessary, display the target employee’s schedule.
 6) Click on the day you wish to copy to.
 7) Click on the Copy button.
 8) Select Paste day.

To copy weeks from one employee to another:

 1) Display the employee’s schedule.
 2) Click on the day you wish to copy.
 3) Click on the Copy button.
 4) Select Copy schedule.
 5) Display the target employee’s schedule.
 6) Click on the day you wish to copy to.
 7) Click on the Copy button.
 8) Select Paste schedule.

To copy weeks to a template for later use:

 1) Display the employee’s schedule.
 2) Click on the Copy button.
 3) Select Copy schedule to template....
 4) Enter a name for this template, then click Save.

To recall a template to an employee’s schedule:

 1) Display the employee’s schedule.
 2) Click the Copy button.
 3) Select Copy template to schedule....
 4) Click on the template you wish to recall, then click Load.

To copy an entire week’s schedule from a previous week for one employee:

 1) Display the employee’s schedule.
 2) Click the Copy button.
 3) Select Copy a previous schedule....
 4) Click on the week you wish to copy from, then click Select.

Re-Build Necessary Shifts

Sometimes it may be necessary to rebuild the necessary shift
assignments for a particular schedule.  Re-building assignments will
reset the current assignments and then traverse through the list of
scheduled employees and determine which employees are filling
necessary shifts in the system.  Each of the shifts that are filled will be assigned
to the employee who fills it.
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To re-build necessary shifts:

 5) Launch TimeClock Scheduler
 6) Create or open a valid schedule.
 7) From the Tools menu choose Re-Build Shift Assignments…
 8) If you are ready to re-build the shifts, select Proceed otherwise select

Cancel
 9) Select Close when the operation is complete.

Requests

Enter Employee requests for each employee while making the schedule.
This will give you the opportunity to view that employee’s schedule requests and
availability for each day.  In addition, you can enter the number of hours the
employee would like to work for the week.

To enter employee requests:

 1) Start TimeClock Scheduler.
 2) Click on View, then Employee schedule.
 3) Enter the employee number
 4) Click on Req.
 5) From this screen you can enter the employee’s requests including

availability and requested number of hours to work per week.

Shift Pools

Many businesses using TimeClock Scheduler have identical shifts for many
employees.  To save time when entering the same shift multiple times, the Shift
Pool can be used to hold and quickly recall several common shifts.

To add or edit a shift in the pool:

 1) Start TimeClock Scheduler.
 2) From the Tools menu, select Edit Shift Pool....
 3) To add a new shift, click Add.  To edit an existing shift, click on the shift

to edit, then click Edit.
 4) Enter the start and end times for the shift.
 5) Click Ok.
 6) Click Exit.

To schedule an employee with a shift from the pool:

 1) Display the employee’s schedule.
 2) Click on the day to which you wish to add the shift.
 3) Click on the Pool button.
 4) Click on the appropriate shift.
 5) Select a job code for the employee.
 6) Optionally, enter a description for the shift.
 7) Click Ok.
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Necessary Shifts

For other situations, when certain shifts must be filled each week, the
Necessary Shifts feature can be used to check that the positions are filled.  Note
that the Necessary Shifts feature only provides checks; it does not schedule
employees automatically.

To create or edit a necessary shift:

 1) Start TimeClock Scheduler.
 2) From the Tools menu, select Edit Necessary Shifts....  If this option is

grayed out you must first create or open a schedule.
 3) Click on the desired day to edit in the tabs at the top of the window.
 4)  If you are adding a new shift, click Add.  Otherwise, click on the shift

you want to edit, and click Edit.
 5) Enter the appropriate values for Time In and Time Out.
 6) Select a job code for this shift.
 7) Optionally, enter a description for this field.
 8) Click Ok.

To copy necessary shifts to other days:

 1) Start TimeClock Scheduler.
 2) From the Tools menu, select Edit Necessary Shifts....  If this option is

grayed, you must first create or open a schedule.
 3) Select the day you want to copy from by using the day tabs at the top of

the window.
 4) Select each of the shifts you would like to copy to another day.
 5) Click Copy and a list of all days will be displayed.
 6) Select the days you want to copy the shifts to.
 7) Click Ok.

To schedule employees in necessary shifts:

 1) Display the employee’s schedule.
 2) Click on the appropriate day.
 3) Click the Shifts button.
 4) Double-click the appropriate shift.

TimeClock Plus will also automatically fill necessary shifts with
manually entered shifts.  For example, if you have a necessary shift on
Monday from 9AM to 5PM in job code 1 and you manually enter a shift
for an employee for this time frame and job code; the employee will
automatically be recorded as filling that necessary shift.

See Scheduler Reports, p. 42 for information on printing out the necessary
shifts and their assignments.
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Special Shifts

TimeClock Plus provides three special shifts: OFF, ON CALL, and OPEN.
The first two are for reference purposes only: they will display while editing shifts,
and print out on most scheduler reports, but they do not affect operation of
TimeClock Plus in any way.

The OPEN shift allows an employee to clock in and out at any time during
the shift, regardless of scheduler restrictions.  This is useful for on-call
employees or backup personnel.  Employees scheduled as OPEN can clock in
and out, but will not appear as absent, and differences will not show up on the
Job Scheduled vs. Actual report.

The OFF and ON CALL shifts are listed for the entire day.  The OPEN shift
can be scheduled for any time range a normal shift can.

To schedule a special shift:

 1) Display the employee’s schedule.
 2) Click on the appropriate day.
 3) Click the Pool button.
 4) Double-click on the special shift that you want to schedule the employee

for.
 5) If you are scheduling an OFF or ON CALL shift, optionally enter a

description for this shift.
 6) If you are scheduling an OPEN shift, enter the start and end times of the

OPEN period.
 7) Click Ok.

Transferring Sick and Vacation Time

Sick and Vacation time that is prescheduled can automatically be entered
into TimeClock Plus.  This is the only time that any operation performed in
TimeClock Scheduler has any effect on TimeClock Plus’s record of actual times.
The transfer only affects the currently open week.

Example: Fred Bloggs has known about a vacation that he was planning to
take on Thursday and Friday.  His supervisor entered him in the scheduler under
job code 1002 (Vacation Pay) with his normal hours of 9–5 for those days.
Because TimeClock Manager has not been told about these hours, if a report is
printed from TimeClock Manager, no mention of vacation time is made.  In
addition, Fred would be listed as absent.  The supervisor performs this transfer,
which tells TimeClock Manager about the scheduled vacation time, and then
prints out a report from TimeClock Manager.  This report shows Fred Bloggs as
clocked in at 9–5 under job code 1002 for the correct days.

To transfer sick and vacation times from Scheduler:

 1) Start TimeClock Scheduler.
 2) From the Tools menu, select Transfer Sick/Vac Time.
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 3) If you want to transfer sick time, select the box Transfer sick hours to
current week.

 4) If you want to transfer vacation time, select the box Transfer vacation
hours to current week.

 5) If you only want to transfer certain employees, click Criteria and enter
the information for the employees you want to transfer.  (See Criteria, p.
62)

 6) Click Process.
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12.  WinRemote 32
WinRemote is the interface program between TimeClock Plus and a Remote

Data Terminal (RDT).  One copy of WinRemote will simultaneously drive up to 16
RDTs on one computer; there is no need to run the program multiple times.

After being launched, WinRemote displays a list of each available port on
the computer.  All operations are performed on the currently selected serial port.
For example, if an RDT on COM4: is to be configured, the COM4: button must be
selected before Configure is clicked.

Configuring

The Configure screen allows individual RDT’s behavior to be configured.
Each option can be set independently of other RDT’S settings.   The following
table shows the defaults for each of the options.

Display system time Activates a digital clock on the RDT display
during periods of inactivity.  Note that the time
displayed is taken from the computer where
the RDT is attached and not the RDT itself.

Beep when key pressed Provides the RDT user with a short beep to
confirm each key.  This option should be off if
you are using magnetic cards.

Confirm name on mag card
swipe

Enables a screen that prompts the employee
for verification after a card is swiped.

Confirm successful clock in/out Enables a screen that informs the employee
when a clock in or out has been successfully
completed.

Log clock in/out failures Causes incomplete or aborted transactions to
be logged to a file in the working directory.  If
you are getting a number of employees that
say they are clocking in, but there is no record
in the TimeClock, enable this option and check
the logfile to determine if their clock in attempts
are being cancelled due to timeouts or other
reasons.  Most often transactions are not
recorded due to the employee not completing
a transaction.

The data is logged to a file in the format
“winrmt<port>.log”.  For example, port 2 would
log to a file “winrmt2.log” in the working
directory.
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Allow Mag card test with 00 Allows an administrator to test the number
encoded on a magnetic card by pressing 00
(zero zero) on the keypad while it is idle.

Allow ID terminal with 11 Allows an administrator to see which serial port
and activity time on a particular RDT by
pressing 11 on the RDT.

Activate port on program
startup

Causes the terminal connected to the specified
port to automatically start when the
WinRemote software is started.

Idle release delay The number of seconds that an RDT will wait
at any given prompt before it assumes the user
has walked away.  A value of zero indicates
infinite wait.

Language file Used to allow languages other than English to
be used on an RDT.  Language files can be
created from the TimeClock Manager under
the Configuration menu.

Time Server If you are running on a Windows NT/95/98
network and have setup a Time Server, use
this option to configure the location of that
server.

Starting and Stopping

The Start and Stop buttons will start and stop the selected RDT.  They have
no permanent effect; when WinRemote is restarted, all serial ports are activated
if and only if the option Activate port on program startup is on.  This option is
not affected by the Start or Stop buttons.

Editing Employees

Managers can edit employee hours from the RDT.  See Editing Hours on the
RDT on page 33.

Activity Log

WinRemote keeps a log of all successful transactions made on each RDT,
as well as when the RDT is started and stopped.  The Save button writes the log
to a text file.
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13.  Appendices

RDT

The Remote Data Terminal is an ASCII serial terminal, using a subset of the
EIA RS232 interface.  It is only a terminal, and has no memory or processor
outside of what is necessary to drive the terminal.  The RDT communicates at
9600 BPS with 8 data bits, no parity, and 1 stop bit.  No form of handshaking is
supported.  It is not necessary to program Windows or the UART with these
settings; WinRemote will automatically program the Windows driver with the
appropriate settings on startup.

Frequently Asked Questions

♦  TimeClock didn’t convert an older version’s databases. Why?
TimeClock converts databases during the company setup phase.  If you

specified to install TimeClock Plus into a directory other than the directory where
your previous version of TimeClock was installed, you should have received a
message about converting from a previous version into the new directory.  You
should answer yes to this question and specify the directory where TimeClock
Plus was previously installed to ensure that the data is copied into the new
install.  If you have accidentally created an empty company, you should enter
TimeClock Manager, choose Select Company from the File menu, and delete
the company.   You should then recreate the company to convert previous data.

♦  How do I make TimeClock obtain the time from a Windows NT machine
located on my network?
If you are running a Windows NT machine on your network, you must have

TCP/IP installed and you must have a program called TIMESV32 running as a
service (See p. 27 for setup instructions). Once this is done, select Configure on
the on-screen TimeClock (in the pull-down menu under the yellow clock icon in
the top left corner of the window) and select the Time Server tab. You then type
in the IP address or name (without the slashes) of your server.

If you are using the RDT, select the Configure button in WinRemote 32.
With the configuration screen visible, select the Time Server button.  Enable the
Time Server and type the IP address in the space provided.

 If you have verified that the TIMESV32 service is running and you still can’t
get it to work, try going to a DOS prompt and ping your server.  If it is
unreachable, you probably do not have TCP/IP configured correctly. Contact
your network administrator.

The Time Server Tester application is also useful to determine that the time
is being obtained from the Time Server.  This application can be launched from
the TimeClock group on the Start Menu.
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♦  How to I make TimeClock obtain the time from a Windows 95/98
machine on my network?
You must have TCP/IP running as a network protocol. Run the program

called Time Server (TIMESVR.EXE) on your Windows 95/98 machine. Once this
is running, it must stay running (i.e. minimized if desired) and the RDT and/or on-
screen TimeClock must be configured to grab the time off of that machine (via its
TCP/IP address or machine name).

See the previous FAQ for more information.

♦  I have setup the time server and it seems to be functioning properly, but
when I clock in the client machine reports the time to be different from
that of the server by X number of hours.  What is wrong?
The most likely problem is that your server and client machines are set to

different time zones.  The TimeClock system automatically adjusts the time from
the server to be the correct time in the time zone where the computer is located.
To correct this problem, launch the Control Panel on each of the machines, then
select Date/Time.  Ensure that both systems are set with the correct time zone.

♦  Why won’t reports print on my printer?
The most common problem when printing out reports is that the incorrect

date ranges or criteria have been selected for the report. Verify the date range,
and under the report criteria make sure that you have selected the proper
employee and job code range to print.  Try viewing the report on screen to
ensure that data actually exists for the date range and criteria specified.  For
more information on Criteria see p. 62.

If you are able to view the report on screen correctly before printing, then the
printing problem that you are having is not a TimeClock error. TimeClock uses
the installed Windows printer driver to print its reports. If nothing prints out, verify
your physical connection to the printer. Also, verify that you are using the latest
printer driver from Microsoft or your printer’s manufacturer.

♦  Why won’t my early and late clock restrictions work?
The number one error that people make when setting this feature up is that

they do not set up their Remote Terminal Restriction and TimeClock Restriction
passwords in the Configuration | Preferences | Passwords screen. These must
be set up first.  TimeClock allows users to clock in/out if a supervisor enters the
correct password.  If there is no password, TimeClock assumes no restriction.
See passwords p. 73 for more information.

You must also have a schedule set up for the employee that you wish to
restrict.  This is the only way that the computer knows that the employee is
indeed early or late.  If you have set up the employee’s schedule for the current
week, make sure that you have selected the appropriate check boxes and
entered the correct numbers under the employee’s Scheduler Tab in the Edit
Employee screen.

♦  What should I do when I get a database error while closing a week?
The most important thing to remember is to not try to close the week again.

When the week is closed, the current week’s data is removed from the main
database and backed up. Attempting to close the same week twice will overwrite
this information and the data will be lost.
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This can be caused from a variety of reasons, from database corruption to
networking problems.  Give Tech Support a call at (915) 223-9300 between the
hours of 12:00pm - 5:00pm CST, Monday - Friday.

♦  How do I edit an employee’s hours?
From the TimeClock Manager, select the employee number under Employee

| Edit Hours... and you can see all of the punches that the employee has had for
the current week.  Each may be edited, or complete entries can be added or
deleted.

If you wish to add a break to the employee’s punches, find two adjacent
punches on the screen (i.e. employee clocked out at 12:00pm and punched back
in at 1:00pm.) Select the first punch and click the break button. The highlighted
punch will turn red and a figure will appear under the Break column (in this case,
60u). This indicates that a 60-minute break was taken.

♦  When employees clock in, they are asked for a job code. Why?
The employee has more than one clockable job code in his list of job codes.

Edit the employee’s information (under Employee | Edit) and look under the Jobs
tab. The Clockable column will indicate “yes” for a clockable job code, and if
there is more than one “yes” then the employee will be asked to choose which
one to clock in under.  Making only one code clockable can eliminate this.

♦  I receive an error “Employee Number Not Found” when clocking in.
Why?
Make sure that the employee is using the correct number when clocking in!

This could be from mistyping the number when entering them into the master
employee list, or the employee could be mistyping their own code. Verify that the
employee knows his/her code.

If a magnetic card reader is being used, see if the card that the employee is
using is encoded with the correct employee number. To identify a mag card’s
number, see “How do I test the number on a magnetic card?”

♦  What is Job Costing and the Job Costing Module?
The Job Cost Module is an inexpensive addition to the TimeClock Plus

software by Data Management, Inc.  This flexible module allows a more detailed
means of tracking employee time and attendance.  Along with the added tracking
feature are four additional reports, which are designed to show how much time
has been spent on each job.

The management simply keeps a list of all possible “job costing codes” up to
date— this is much like the “Master Job Code List” of TimeClock Plus.  These
cost codes will be global to all employees who are allowed to work under them.
The employee will clock in (as normal) and the system will prompt him for the job
cost code.  He may type it or select one from the list.

Example: A car manufacturing company employee could clock in under the
job code number 16 -  “Windshield Repair Man,” then he could work on the job
cost code number GF109 - “Green Ford.”  Two hours later, he finishes the Ford
and changes his cost code to YH443 -  “Yellow Honda.”  The entire day, he does
this.  The management now has record of all hours this employee worked as a
windshield repair man (from the job code), and also all hours that were spent on
the yellow Honda, green Ford, etc. (from the cost code).  A report could be
printed showing all hours company wide that were worked for the individual cars,
or a report showing all hours that the windshield department worked on each car,
etc.
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The job cost module adds more flexibility and allows the job codes to be
used in a more generic fashion (leaving the detail to the cost codes).  This
module is simply a disk that you would install (as you did TimeClock Plus) that
would convert the TimeClock Manager giving new reports and several new menu
items.

♦  What is the purpose of the Scheduler?
The scheduler is to allow TimeClock Manager to use the absence and tardy

functions that it has available. The computer must know when the employee is
supposed to be at work, and it references the schedules that you have created to
do this. You may also print out master schedules to post for your employees to
see, or for your own use. You may copy schedules from week to week if the
employee works the same scheduled time, but the Scheduler will in no way
automatically generate schedules for employees.

♦  My computer has a mouse and modem. Will my RDT work?
Each of these is a serial device, and most IBM-compatible computers only

have two serial ports (i.e. COM1 and COM2). For example, if your mouse is on
COM1 and your modem is on COM2, then all of your available serial ports are
occupied. Also, if you have an internal modem, more than likely one of the serial
ports has been disabled in the bios. This essentially “disconnects” one of the
serial ports on the back of the computer, so even if the RDT is plugged into it, the
connection is dead!

♦  Can I use COM3 or COM4 for my RDT?
The serial ports COM3 and COM4 can be configured to run an RDT if you

add them using a different IRQ than that of COM1 or COM2.  For example, if you
do not have any devices in your system using IRQ 5, you can add another serial
port using COM3 IRQ 5 and the RDT will function properly.  If you attempt to add
COM3 using the same IRQ as COM1 or COM2, you will have problems getting
the RDT or any other device working on the port.

♦  How do I free up a serial port for an RDT to use?
Some computers have a PS/2 style mouse connector that is a dedicated

mouse port that uses IRQ12. These can be purchased as an add-in board, or if
one is already present on your computer, adapters that will allow you to use your
existing DB9 mouse are available.

There are also multi-port boards on the market that allow you to add four or
eight additional serial ports to a computer. Some of these are pricey, but this is
usually the only option if you wish to run more than two RDT’s on one computer!

♦  Can I use a long telephone cable to connect an RDT to the computer?
Absolutely not! Although the cable connectors appear identical, the twisting

of the wires is not the same. Contact your sales representative at (800) 749-8463
for replacement or additional cable.

♦  What is the longest length of cable that my RDT can use?
We have had instances of customers running cable around 1000 feet for the

RDT to an adjacent building.

♦  There is garbage on my RDT’s screen! What could cause this?
Make sure that you are using the cable that was supplied to you when you

purchased the RDT. Remember: A telephone cable will not work.  If you have
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wired the cable through the ceiling or wall, make sure that it is not in the proximity
of fluorescent lighting ballasts, copying machines, laser printers, or fax machines.
Some of these devices emit powerful magnetic fields that can disrupt the signal
through the wiring.

♦  How do I test the number on a magnetic card?
At the normal clock-in screen on the RDT, press the ‘0’ key twice. This will

bring up the mag card test screen. Then swipe the mag card to be tested. The
mag card’s encoded number will be displayed on screen. The display will prompt
you to press a key before continuing. Note that you must press a key before
testing the next mag card, or you will receive an incorrect result on the next mag
card to be tested. Press the escape key to return to the normal TimeClock
display.

♦  The time is the only item displaying on the RDT. Why?
If the time is actually updating on the RDT screen (the seconds are counting)

then the RDT probably lost power recently. Check to make sure your power
connections are secure. To refresh the screen, press the period key (.) on the
keypad once.

If the time is not updating (the seconds are not counting) you may have a
bad connection between the RDT and the computer. Check the connection of the
silver cable going into the RDT, as well as the cable’s connection at the back of
the computer.

♦  I want to run several RDTs on one computer but I do not have enough
communications ports.  Is there anything that I can do?
There are several multi-port serial cards available that work with TimeClock

Plus.  We currently support the use of the BOCA BB1004 or BB1008 boards for
this purpose.   These boards allow the sharing of an IRQ for all ports which
makes configuration easier than most other boards.  Although any multi-port
serial card that has a standard pin-out will work with the RDT, TimeClock support
may not be able to assist you in configuring another type of card in your system.
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Technical Support Policy

Data Management Inc. offers 90 days of free technical support with each
serial number of TimeClock Plus.  After the 90-day period has elapsed, an
additional 30 minutes of running time is available free of charge. Time will be
deducted only when used (i.e. if you have a question 4 months from then end of
the 90-day free period and it takes our tech support 5 minutes to answer that
question, you will still have 25 minutes remaining).

If additional tech support is desired, it can be purchased for $1.00 per minute
or in 30-minute blocks for $27.00.  Unlimited quarterly support is available for
$299.00.

All technical support calls are answered in the order they are received.
Technical support policy is subject to change without notice. Technical support is
available Monday through Friday (excluding holidays), 12PM - 5PM CST and can
be reached at (915) 223-9300. Please be at your computer and have your serial
number ready when you call.  Registered users can also submit questions via
mail, e-mail, or fax. Please include your serial number, address or fax number
and a complete description of the problem. A DMI support representative can
only respond to written questions with written answers, so be sure to include your
address, email or fax number.  Written questions are charged in the same
manner as telephone questions.

For written support:

DMI Technical Support
3322 West Loop 306
San Angelo Texas 76904
915-223-9104 fax

support@timeclockplus.com
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